User Guide
HP LaserJet Pro MFP M521
User Guide
## Table of contents

### 1 Product introduction
- Product comparison ................................................................. 2
- Product views ........................................................................... 4
  - Product front view ................................................................. 4
  - Product back view .................................................................. 5
  - Interface ports ........................................................................ 6
  - Serial number and model number location ............................... 7
- Control panel ............................................................................ 8
  - Control-panel layout .............................................................. 8
  - Control-panel Home screen ................................................... 9
  - Control panel help system ...................................................... 10
- Print product reports ................................................................. 11

### 2 Paper trays
- Supported paper sizes ............................................................... 14
- Supported paper types ............................................................. 16
- Tray 1 .................................................................................... 17
  - Tray capacity and paper orientation ...................................... 17
  - Load Tray 1 ........................................................................... 18
- Tray 2 and optional Tray 3 ........................................................ 20
  - Tray capacity and paper orientation ...................................... 20
  - Load Tray 2 and optional Tray 3 ............................................ 21
- Use paper output options ........................................................ 23
  - Print to the standard output bin ............................................. 23
  - Print to the rear output bin ................................................... 23

### 3 Parts, supplies, and accessories
- Order parts, accessories, and supplies ...................................... 26
- HP policy on non-HP supplies .................................................. 27
- HP anticounterfeit Web site ...................................................... 28
- Print when a toner cartridge is at estimated end of life .................. 29
<table>
<thead>
<tr>
<th>Enable or disable the Very Low Setting</th>
<th>29</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer self-repair parts</td>
<td>31</td>
</tr>
<tr>
<td>Accessories</td>
<td>33</td>
</tr>
<tr>
<td>Toner cartridge</td>
<td>34</td>
</tr>
<tr>
<td>Toner-cartridge view</td>
<td>34</td>
</tr>
<tr>
<td>Toner-cartridge information</td>
<td>35</td>
</tr>
<tr>
<td>Recycle the toner cartridge</td>
<td>35</td>
</tr>
<tr>
<td>Toner-cartridge storage</td>
<td>35</td>
</tr>
<tr>
<td>HP policy on non-HP toner cartridges</td>
<td>35</td>
</tr>
<tr>
<td>Replace the toner cartridge</td>
<td>36</td>
</tr>
</tbody>
</table>

### 4 Print

**Supported print drivers (Windows)** ................................................................. 40
- HP Universal Print Driver (UPD) ................................................................. 40
  - UPD installation modes ................................................................. 41
**Change print-job settings (Windows)** .......................................................... 42
  - Priority for changing print-job settings ....................................... 42
  - Change the settings for all print jobs until the software program is closed 42
  - Change the default settings for all print jobs .................................. 42
  - Change the product configuration settings ....................................... 43
**Change print-job settings (Mac OS X)** ....................................................... 44
  - Priority for changing print-job settings ....................................... 44
  - Change the settings for all print jobs until the software program is closed 44
  - Change the default settings for all print jobs .................................. 44
  - Change the product configuration settings ....................................... 45
**Print tasks (Windows)** .................................................................................. 46
  - Use a printing shortcut (Windows) .................................................. 46
  - Create printing shortcuts (Windows) ................................................. 48
  - Automatically print on both sides (Windows) .................................... 51
  - Manually print on both sides (Windows) .......................................... 53
  - Print multiple pages per sheet (Windows) ....................................... 57
  - Select the page orientation (Windows) ............................................. 59
  - Select the paper type (Windows) ..................................................... 61
  - Print the first or last page on different paper (Windows) .................. 64
  - Scale a document to fit page size (Windows) .................................... 67
  - Create a booklet (Windows) ............................................................ 69
  - Select the paper size (Windows) ..................................................... 70
  - Select a custom paper size (Windows) ............................................. 70
  - Print watermarks (Windows) ........................................................... 71
  - Cancel a print job (Windows) ......................................................... 71
**Print tasks (Mac OS X)** .................................................................................. 73
5 Copy ................................................................................................................................................. 83

Set new default copy settings ........................................................................................................... 84
Restore copy default settings ........................................................................................................... 85
Make a single copy ............................................................................................................................... 86
Make multiple copies ............................................................................................................................ 87
Copy a multiple-page original ........................................................................................................... 88
Copy identification cards .................................................................................................................... 89
Collate a copy job .................................................................................................................................. 90
Copy on both sides (duplex) .................................................................................................................. 91
  Copy on both sides automatically ....................................................................................................... 91
  Copy on both sides manually ............................................................................................................... 92
Reduce or enlarge a copy ....................................................................................................................... 93
Optimize copy quality ............................................................................................................................ 94
Adjust the lightness or darkness for copies .......................................................................................... 95
Copy in draft mode ............................................................................................................................... 96
Set the paper size and type for copying on special paper ...................................................................... 97

6 Scan .................................................................................................................................................. 99

Scan by using the HP Scan software (Windows) .................................................................................. 100
Scan by using the HP Scan software (Mac OS X) .................................................................................. 101
Scan to a USB flash drive ...................................................................................................................... 102
Set up scan to network folder and scan to email features ...................................................................... 103
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure the scan to network folder feature</td>
<td>103</td>
</tr>
<tr>
<td>Configure the scan to email feature</td>
<td>103</td>
</tr>
<tr>
<td>Scan to a network folder</td>
<td>104</td>
</tr>
<tr>
<td>Scan to email</td>
<td>105</td>
</tr>
<tr>
<td>Scan by using other software</td>
<td>106</td>
</tr>
<tr>
<td>Scan from a TWAIN-compliant program (Windows)</td>
<td>106</td>
</tr>
<tr>
<td>Scan from a WIA-compliant program (Windows)</td>
<td>106</td>
</tr>
</tbody>
</table>

7 Fax

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up the product for fax</td>
<td>110</td>
</tr>
<tr>
<td>Connect the fax port to a telephone line</td>
<td>110</td>
</tr>
<tr>
<td>Connect additional devices</td>
<td>110</td>
</tr>
<tr>
<td>Set up fax with a telephone answering machine</td>
<td>111</td>
</tr>
<tr>
<td>Set up fax with an extension phone</td>
<td>112</td>
</tr>
<tr>
<td>Set up for stand-alone fax</td>
<td>112</td>
</tr>
<tr>
<td>Configure the fax time, date, and header</td>
<td>112</td>
</tr>
<tr>
<td>Use the control panel to set the fax time, date, and header</td>
<td>113</td>
</tr>
<tr>
<td>Use the HP Fax Setup Wizard to set the fax time, date, and header (Windows)</td>
<td>113</td>
</tr>
<tr>
<td>Use the phone book</td>
<td>114</td>
</tr>
<tr>
<td>Create and edit speed-dial entries</td>
<td>114</td>
</tr>
<tr>
<td>Create and edit group-dial entries</td>
<td>114</td>
</tr>
<tr>
<td>Delete speed-dial entries</td>
<td>115</td>
</tr>
<tr>
<td>Delete group-dial entries</td>
<td>115</td>
</tr>
<tr>
<td>Configure send fax settings</td>
<td>116</td>
</tr>
<tr>
<td>Set special dialing symbols and options</td>
<td>116</td>
</tr>
<tr>
<td>Set a dialing prefix</td>
<td>116</td>
</tr>
<tr>
<td>Set the dial tone detection</td>
<td>116</td>
</tr>
<tr>
<td>Tone dial or pulse dial</td>
<td>117</td>
</tr>
<tr>
<td>Set autoreodial options</td>
<td>117</td>
</tr>
<tr>
<td>Set light/dark and resolution</td>
<td>118</td>
</tr>
<tr>
<td>Set the default light/dark (contrast) setting</td>
<td>118</td>
</tr>
<tr>
<td>Set resolution settings</td>
<td>118</td>
</tr>
<tr>
<td>Set billing codes</td>
<td>119</td>
</tr>
<tr>
<td>Configure receive fax settings</td>
<td>120</td>
</tr>
<tr>
<td>Set fax forwarding</td>
<td>120</td>
</tr>
<tr>
<td>Set the answer mode</td>
<td>120</td>
</tr>
<tr>
<td>Block or unblock fax numbers</td>
<td>121</td>
</tr>
<tr>
<td>Set the number of rings-to-answer</td>
<td>121</td>
</tr>
<tr>
<td>Set distinctive ring</td>
<td>122</td>
</tr>
<tr>
<td>Use autoreduction for incoming faxes</td>
<td>123</td>
</tr>
<tr>
<td>Set fax reprint settings</td>
<td>123</td>
</tr>
</tbody>
</table>
Set the fax sounds volume ..................................................................................................... 123
Set the alarm volume, phone-line volume, and ring volume ........................................ 124
Set stamp-received faxes ............................................................................................................... 124
Set the private receive feature ....................................................................................................... 124
Set fax polling ............................................................................................................................. 125
Use fax ........................................................................................................................................ 126
Supported fax programs ................................................................................................................. 126
Cancel a fax ................................................................................................................................... 126
Cancel the current fax .................................................................................................................. 126
Cancel a pending fax job .............................................................................................................. 126
Delete faxes from memory ............................................................................................................ 127
Use fax on a DSL, PBX, or ISDN system .................................................................................. 128
DSL ................................................................................................................................ 128
PBX ................................................................................................................................ 128
ISDN .................................................................................................................................... 128
Use fax on a VoIP service ............................................................................................................. 128
Fax memory contents are retained when there is a loss of power ........................................ 128
Security issues when connecting internal networks to public phone lines ....................... 128
Fax from the flatbed scanner ....................................................................................................... 129
Fax from the document feeder ................................................................................................. 130
Use speed dials and group-dial entries ..................................................................................... 130
Send a fax from the software (Windows) ................................................................................. 131
Send a fax by dialing from a telephone connected to the fax line ........................................ 132
Send a fax with confirmation ....................................................................................................... 132
Schedule a fax to be sent later .................................................................................................... 132
Send a fax combining an electronic and paper document ..................................................... 133
Use access codes, credit cards, or calling cards ......................................................................... 133
Send faxes internationally ........................................................................................................... 133
Print a fax ................................................................................................................................... 134
Reprint a fax .............................................................................................................................. 135
Automatically print on both sides of received faxes ............................................................ 136
Print a stored fax when the private receive feature is on ..................................................... 136
Receive faxes when fax tones are audible on the phone line .............................................. 136

8 Manage and maintain ...................................................................................................................... 137
Use the HP Reconfiguration Utility to change the product connection (Windows) ................ 138
Set up HP Wireless Direct Printing ......................................................................................... 139
Use HP Web Services applications .......................................................................................... 140
Configure IP network settings ................................................................................................. 141
Printer sharing disclaimer ........................................................................................................... 141
View or change network settings .............................................................................................. 141
Manually configure IPv4 TCP/IP parameters from the control panel ........................................ 141
Rename the product on a network ........................................................................................................ 141
Link speed and duplex settings ........................................................................................................ 143
HP Device Toolbox (Windows) .................................................................................................................. 144
HP Utility for Mac OS X ................................................................................................................................. 146
Open HP Utility ........................................................................................................................................ 146
HP Utility features ....................................................................................................................................... 146
Use HP Web Jetadmin software .................................................................................................................. 147
Economy settings ........................................................................................................................................ 148
Print with EconoMode ................................................................................................................................. 148
Set the Sleep Delay ..................................................................................................................................... 148
Set the Auto Power Down delay ................................................................................................................... 148
Product security features ............................................................................................................................... 150
Lock the product ......................................................................................................................................... 150
Set or change the product password .............................................................................................................. 150
Upgrade the firmware ................................................................................................................................... 151
Manually upgrade the firmware ..................................................................................................................... 151
Set the product to automatically upgrade the firmware ................................................................................. 151

9 Solve problems ........................................................................................................................................... 153

Solve problems checklist ................................................................................................................................. 154
Step 1: Make sure that the product is set up correctly .................................................................................... 154
Step 2: Check the cabling or wireless connection .......................................................................................... 154
Step 3: Check the control panel for error messages ...................................................................................... 155
Step 4: Check the paper .................................................................................................................................. 155
Step 5: Check the software ................................................................................................................................ 155
Step 6: Test print functionality .......................................................................................................................... 155
Step 7: Test copy functionality .......................................................................................................................... 155
Step 8: Test the fax functionality ...................................................................................................................... 156
Step 9: Check the toner cartridge .................................................................................................................... 156
Step 10: Try sending a print job from a computer ........................................................................................... 156
Step 11: Verify that the product is on the network .......................................................................................... 156

Restore the factory-set defaults .................................................................................................................... 157
Control panel help system ............................................................................................................................... 158
Paper feeds incorrectly or becomes jammed ..................................................................................................... 159
The product does not pick up paper ................................................................................................................ 159
The product picks up multiple sheets of paper ............................................................................................... 159
The document feeder jams, skews, or picks up multiple sheets of paper ....................................................... 159
Prevent paper jams from the paper trays ......................................................................................................... 160
Clear jams ...................................................................................................................................................... 161
Jam locations ................................................................................................................................................ 161
Clear jams in the document feeder ................................................................. 162
Clear jams in the output area ........................................................................ 164
Clear jams in Tray 1 ....................................................................................... 166
Clear jams in Tray 2 or optional Tray 3 .......................................................... 169
Clear jams in the fuser .................................................................................. 173
Clear jams in the duplexer .......................................................................... 175

Improve print quality .................................................................. 177
- Print from a different software program .................................................. 177
- Set the paper-type setting for the print job ............................................... 177
  - Check the paper-type setting (Windows) .............................................. 177
  - Check the paper-type setting (Mac OS X) .......................................... 178
- Check the toner-cartridge status ............................................................. 178
- Print a cleaning page .............................................................................. 178
- Visually inspect the toner cartridge ........................................................ 178
- Check the paper and printing environment ............................................ 179
  - Use paper that meets HP specifications ............................................. 179
  - Check the product environment .......................................................... 179
- Check the EconoMode settings ............................................................... 179
- Try a different print driver ..................................................................... 180

Improve copy quality .................................................................................. 182
- Check the scanner glass for dirt and smudges ........................................ 182
- Check the paper settings ....................................................................... 183
- Optimize for text or pictures ................................................................. 183
- Edge-to-edge copying ............................................................................ 184
- Clean the pickup rollers and separation pad in the document feeder ....... 184

Improve scan quality ................................................................................ 186
- Check the scanner glass for dirt and smudges ........................................ 186
- Clean the pickup rollers and separation pad in the document feeder ....... 187

Improve fax quality .................................................................................. 189
- Check the scanner glass for dirt and smudges ........................................ 189
- Check the send-fax resolution setting ...................................................... 190
- Check the error correction setting .......................................................... 190
- Send to a different fax machine ............................................................. 190
- Clean the pickup rollers and separation pad in the document feeder ....... 191
- Check the fit-to-page setting ................................................................. 191
- Check the sender's fax machine ............................................................. 192

The product does not print or it prints slowly .............................................. 193
- The product does not print ..................................................................... 193
- The product prints slowly ..................................................................... 193

Solve walk-up USB printing problems ...................................................... 194
- The USB Flash Drive menu does not open when you insert the USB flash drive .......................... 194
The file does not print from the USB flash drive ................................................................. 194
The file that you want to print is not listed in the USB Flash Drive menu .................... 194

Solve fax problems .................................................................................................................. 195
Checklist for solving fax problems ........................................................................................ 195
Perform a fax diagnostic test ............................................................................................... 196
Fax trace report ...................................................................................................................... 197
Fax error report printing ......................................................................................................... 197
  Print all fax reports .......................................................................................... 197
  Print individual fax reports ........................................................................ 197
  Set the fax error report .................................................................................. 198
Set the fax-error-correction mode ....................................................................................... 198
Change the fax speed .............................................................................................................. 198

Solve problems sending faxes .............................................................................................. 199
  An error message displays on the control panel .................................................. 199
    The Communication error message appears ............................................ 199
    No dial tone .......................................................................................... 200
    The Fax is busy message appears ......................................................... 200
    The No fax answer message appears ...................................................... 200
    Document feeder paper jam ...................................................................... 201
    The Fax storage is full message appears ................................................ 201
    Scanner error .......................................................................................... 202
  The control panel displays a Ready message with no attempt to send the fax .......... 202
  The control panel displays the message "Storing page 1" and does not progress beyond that message ......................................................... 202
  Faxes can be received, but not sent ........................................................................ 202
  Product is password protected ............................................................................. 203
  Unable to use fax functions from the control panel ............................................... 203
  Unable to use speed dials ..................................................................................... 203
  Unable to use group dials ..................................................................................... 203
  Receive a recorded error message from the phone company when trying to send a fax .................................................................................. 204
  Unable to send a fax when a phone is connected to the product ......................... 204

Solve problems receiving faxes ............................................................................................. 204
  The fax does not respond ..................................................................................... 205
    The fax has a dedicated phone line ............................................................. 205
    An answering machine is connected to the product ...................................... 205
    The Answer Mode setting is set to the Manual setting ............................... 206
    Voice mail is available on the fax line ......................................................... 206
    The product is connected to a DSL phone service ....................................... 206
    The product uses a fax over IP or VoIP phone service .................................. 206
    An error message displays on the control panel ......................................... 207
1 Product introduction

- Product comparison
- Product views
- Control panel
- Print product reports
## Product comparison

<table>
<thead>
<tr>
<th>Feature</th>
<th>M521dn A8P79A</th>
<th>M521dw A8P80A</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paper handling</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tray 1 (100-sheet capacity)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Tray 2 (500-sheet capacity)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Optional Tray 3 (500-sheet capacity)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Standard output bin (250-sheet capacity)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rear output bin (50-sheet capacity)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Automatic duplex printing</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Supported operating systems</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows XP, 32-bit, Service Pack 2 and greater</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Vista, 32-bit and 64-bit</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows 7, 32-bit and 64-bit</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows 2003 Server (32-bit, Service Pack 1 or greater), print and scan drivers only</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows 2008 Server (32-bit, 64-bit, and R2), print and scan drivers only</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Mac OS X v10.6.8 and later</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Connectivity</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hi-Speed USB 2.0</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>10/100/1000 Ethernet LAN connection</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Wireless network connection</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>256 MB RAM</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Control-panel display</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color graphical touch screen</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prints 40 pages per minute (ppm) on A4-size paper and 42 ppm on Letter-size paper</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Walk-up USB printing (no computer required)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copies at up to 20 ppm</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Copy resolution is 300 dots per inch (dpi)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>This document feeder holds up to 50 pages and supports page sizes from 127 to 356 mm (5 to 14 in) in length and from 127 to 216 mm (5 to 8.5 in) in width</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Feature</td>
<td>M521dn A8P79A</td>
<td>M521dw A8P80A</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Flatbed scanner supports page sizes up to 297 mm (11.7 in) in length and up to 215 mm (8.5 in) in width</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Automatic duplex copying</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Scan</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scans in black and white with resolution up to 1200 dpi from the flatbed glass</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Scans in color with resolution up to 300 dpi from the document feeder and up to 600 dpi from the flatbed glass</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Automatic duplex scanning</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Scan to Email (no software required)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Scan to Network Folder (no software required)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Walk-up USB scanning (no computer required)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Fax</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>V.34 with two RJ-11 fax ports</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
Product views

- Product front view
- Product back view
- Interface ports
- Serial number and model number location

Product front view

1. Automatic document feeder
2. Document-feeder output bin
3. Walk-up USB port (for printing and scanning without a computer)
4. Control panel with color touchscreen graphical display
5. On/off button
6. Optional Tray 3
7. Tray 2
8. Tray 1
9. Front-door-release button (access to the toner cartridge)
10. Output-bin extension for long paper
11. Standard output bin
12. Handle to raise the scanner lid
Product back view

1. Rear door and face-up output bin (access for clearing jams)
2. Dust cover for Tray 2 (for printing on legal-size paper)
3. Power connection
4. I/O ports and security lock
### Interface ports

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Slot for a cable-type security lock</td>
</tr>
<tr>
<td>2</td>
<td>Local area network (LAN) Ethernet (RJ-45) network port</td>
</tr>
<tr>
<td>3</td>
<td>Hi-Speed USB 2.0 printing port</td>
</tr>
<tr>
<td>4</td>
<td>Telephone “line out” port for attaching an extension phone, answering machine, or other device</td>
</tr>
<tr>
<td>5</td>
<td>Fax “line in” port for attaching the fax phone line to the product</td>
</tr>
</tbody>
</table>
Serial number and model number location

The model number and serial number are listed on an identification label located on the back of the product. They are also listed on the inside of the front door. The serial number contains information about the country/region of origin, the product version, production code, and the production number of the product.

<table>
<thead>
<tr>
<th>Model name</th>
<th>Model number</th>
</tr>
</thead>
<tbody>
<tr>
<td>M521dn</td>
<td>A8P79A</td>
</tr>
<tr>
<td>M521dw</td>
<td>A8P80A</td>
</tr>
</tbody>
</table>
Control panel

- Control-panel layout
- Control-panel Home screen
- Control panel help system

Control-panel layout

1. Touchscreen display
   Provides access to the product features and indicates the current status of the product.

2. Help button and light
   Provides access to the control-panel help system.

3. Right arrow button and light
   Moves the cursor to the right or moves the display image to the next screen.
   **NOTE:** This button illuminates only when the current screen can use this feature.

4. Cancel button and light
   Clears settings, cancels the current job, or exits the current screen.
   **NOTE:** This button illuminates only when the current screen can use this feature.

5. Wireless light (wireless models only)
   Indicates the wireless network is enabled. The light blinks while the product is establishing a connection to the wireless network.

6. Attention light
   Indicates a problem with the product.

7. Ready light
   Indicates the product is ready.

8. Back button and light
   Returns to the previous screen.
   **NOTE:** This button illuminates only when the current screen can use this feature.

9. Left arrow button and light
   Moves the cursor to the left.
   **NOTE:** This button illuminates only when the current screen can use this feature.

10. Home button and light
    Provides access to the Home screen.
    **NOTE:** This button illuminates only when the current screen can use this feature.
Control-panel Home screen

The Home screen provides access to the product features, and it indicates the product status.

NOTE: Depending on the product configuration, the features on the Home screen can vary. The layout might also be reversed for some languages.

The Home screen features are as follows:

1. **Web Services button**
   - Provides quick access to HP Web Services features, including HP ePrint
   - HP ePrint is a tool that prints documents by using any email enabled device to send them to the product’s email address.

2. **Setup button**
   - Provides access to the main menus

3. **Wireless button (wireless models only)**
   - Provides access to the Wireless menu and wireless status information
   - NOTE: When you are connected to a wireless network, this icon changes to a set of signal strength bars.

4. **Network button (for products connected to a network only)**
   - Provides access to network settings and information. From the network settings screen, you can print the Network Summary page.

5. **Information button**
   - Provides product status information. From the status summary screen, you can print the Configuration Report page.

6. **Supplies button**
   - Provides information about supplies status. From the supplies summary screen, you can print the Supplies Status page.

7. **Fax button**
   - Provides access to the Fax feature

8. **Apps button**
   - Provides access to the Apps menu to print directly from Web applications that you have downloaded from the HP ePrintCenter Web site at www.hpeprintcenter.com

9. **Product status**
   - Indicates whether the product is ready or is processing a job

10. **Scan button**
    - Provides access to the scan feature

11. **Copy button**
    - Provides access to the copy feature

12. **USB button**
    - Provides access to the walkup-USB feature (for printing and scanning without a computer)
Control panel help system

The product has a built-in Help system that explains how to use each screen. To open the Help system, touch the Help button in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can browse through the menu structure by touching the buttons in the menu.

Some Help screens include animations that guide you through procedures, such as clearing jams.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options for that screen.

If the product alerts you of an error or warning, touch the Help button to open a message that describes the problem. The message also contains instructions to help solve the problem.
Print product reports

From the Reports menu, you can print several informative pages about the product.

1. From the Home screen on the product control panel, touch the Setup button.

2. Touch the Reports button.

3. Touch the name of the report that you want to print.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demo Page</td>
<td>Prints a page that demonstrates print quality</td>
</tr>
<tr>
<td>Menu Structure</td>
<td>Prints a map of the control panel-menu layout. The active settings for each menu are listed.</td>
</tr>
<tr>
<td>Configuration Report</td>
<td>Prints a list of all the product settings. Includes network information when the product is connected to a network.</td>
</tr>
<tr>
<td>Supplies Status</td>
<td>Prints the status for each toner cartridge, including the following information:</td>
</tr>
<tr>
<td></td>
<td>• Estimated percentage of cartridge life remaining</td>
</tr>
<tr>
<td></td>
<td>• Approximate pages remaining</td>
</tr>
<tr>
<td></td>
<td>• Part numbers for HP toner cartridges</td>
</tr>
<tr>
<td></td>
<td>• Number of pages printed</td>
</tr>
<tr>
<td>Network Summary</td>
<td>Prints a list of all product network settings</td>
</tr>
<tr>
<td>Usage Page</td>
<td>Prints a page that lists PCL pages, PCL 6 pages, PS pages, pages that were jammed or mispicked in the product, number of pages printed; and reports the page count</td>
</tr>
<tr>
<td>PCL Font List</td>
<td>Prints a list of all the PCL fonts that are installed</td>
</tr>
<tr>
<td>PS Font List</td>
<td>Prints a list of all the PostScript (PS) fonts that are installed</td>
</tr>
<tr>
<td>PCL6 Font List</td>
<td>Prints a list of all the PCL6 fonts that are installed</td>
</tr>
<tr>
<td>Service Page</td>
<td>Prints the service report</td>
</tr>
<tr>
<td>Print Quality Page</td>
<td>Prints a page that helps solve problems with print quality</td>
</tr>
</tbody>
</table>
2 Paper trays

- Supported paper sizes
- Supported paper types
- Tray 1
- Tray 2 and optional Tray 3
- Use paper output options
## Supported paper sizes

*NOTE:* To obtain the best results, select the correct paper size and type in the print driver before printing.

### Table 2-1  Supported paper sizes

<table>
<thead>
<tr>
<th>Size and dimensions</th>
<th>Tray 1</th>
<th>Tray 2 and the optional 500-sheet trays</th>
<th>Automatic duplex printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>216 x 279 mm (8.5 x 11 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Legal</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>216 x 356 mm (8.5 x 14 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Executive</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>184 x 267 mm (7.25 x 10.5 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.5 x 13 in</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>216 x 330 mm (8.5 x 13 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A4</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>210 x 297 mm (8.3 x 11.7 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A5</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>148 x 210 mm (5.8 x 8.3 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A6</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>104 x 148 mm (4.1 x 5.8 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B5 (JIS)</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>182 x 257 mm (7.2 x 10.1 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16K</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>184 x 260 mm (7.2 x 10.25 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16K</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>197 x 273 mm (7.75 x 10.75 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Postcard (JIS)</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 x 148 mm (3.9 x 5.8 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Double Postcard (JIS)</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200 x 148 mm (7.9 x 5.8 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>76 x 127 mm to 216 x 356 mm (3.0 x 5.0 in to 8.5 x 14 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>105 x 148 mm to 216 x 356 mm (4.1 x 5.8 in to 8.5 x 14 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size and dimensions</td>
<td>Tray 1</td>
<td>Tray 2 and the optional 500-sheet trays</td>
<td>Automatic duplex printing</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------</td>
<td>----------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Custom</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>210 x 280 mm to 216 x 356 mm (8.3 x 11 in to 8.5 x 14 in)</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Envelope #10</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>105 x 241 mm (4.1 x 9.5 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope DL</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>110 x 220 mm (4.3 x 8.7 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope C5</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>162 x 229 mm (6.4 x 9.8 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope B5</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>176 x 250 mm (6.9 x 9.8 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Envelope Monarch</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>98 x 191 mm (3.9 x 7.5 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Supported paper types

For a complete list of specific HP-brand paper that this product supports, go to [www.hp.com/support/ljmfpM521series](http://www.hp.com/support/ljmfpM521series).

**NOTE:** To obtain the best results, select the correct paper size and type in the print driver before printing.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Tray 1</th>
<th>Tray 2 and optional 500-sheet trays</th>
<th>Automatic duplex printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>HP EcoSMART</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Light 60–74g</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Midweight 96–110g</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Heavy 111–130g</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Extra Heavy 131–175g</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Transparency</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Labels</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Letterhead</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Envelope</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preprinted</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Prepunched</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Colored</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Bond</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recycled</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rough</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Tray 1

- Tray capacity and paper orientation
- Load Tray 1

Tray capacity and paper orientation

To prevent jams, do not overfill trays. Be sure the top of the stack is below the tray-full indicator. For short/narrow and heavy/glossy paper, load paper to less than half of the tray full indicators.

Table 2-3  Tray 1 capacity

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Specifications</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper</td>
<td>Range: 60 g/m² (16 lb) to 220 g/m² (58 lb)</td>
<td>Maximum stack height: 12 mm (0.5 in)</td>
</tr>
<tr>
<td>Envelopes</td>
<td>75 g/m² (20 lb) to 90 g/m² (24 lb)</td>
<td>Up to 10 envelopes</td>
</tr>
<tr>
<td>Labels</td>
<td>0.10 to 0.14 mm (0.004 to 0.006 in) thick</td>
<td>Maximum stack height: 12 mm (0.5 in)</td>
</tr>
<tr>
<td>Transparencies</td>
<td>0.10 to 0.14 mm (0.004 to 0.006 in) thick</td>
<td>Maximum stack height: 12 mm (0.5 in)</td>
</tr>
</tbody>
</table>

Table 2-4  Tray 1 paper orientation

<table>
<thead>
<tr>
<th>Single-sided printing</th>
<th>Automatic duplex printing and Alternative Letterhead Mode</th>
<th>Envelopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Face-up</td>
<td>Face-down</td>
<td>Face-up</td>
</tr>
<tr>
<td>Top edge leading into the product</td>
<td>Bottom edge leading into the product</td>
<td>Short, postage end leading into the product</td>
</tr>
</tbody>
</table>
Load Tray 1

1. Open Tray 1.

2. Pull out the paper support and fold out the extension.
3. Load the paper into the tray. Make sure that the paper fits under the tabs and below the maximum-height indicators.

4. Adjust the side guides so that they lightly touch the paper stack but do not bend the paper.
Tray 2 and optional Tray 3

- Tray capacity and paper orientation
- Load Tray 2 and optional Tray 3

Tray capacity and paper orientation

To prevent jams, do not overfill trays. Be sure the top of the stack is below the tray-full indicator. For short/narrow and heavy/glossy paper, load paper to less than half of the tray-full indicators.

Table 2-5  Tray 2 and optional Tray 3 capacity

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Specifications</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper</td>
<td>Range: 60 g/m² (16 lb) to 130 g/m² (35 lb)</td>
<td>Equivalent to 500 sheets of 75 g/m² (20 lb)</td>
</tr>
</tbody>
</table>

Table 2-6  Tray 2 and optional Tray 3 paper orientation

<table>
<thead>
<tr>
<th>Single-sided printing</th>
<th>Automatic duplex printing and Alternative Letterhead Mode</th>
<th>Envelopes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Face-down</td>
<td>Face-up</td>
<td>Print envelopes only from Tray 1.</td>
</tr>
<tr>
<td>Top edge at the front of the tray</td>
<td>Bottom edge at the front of the tray</td>
<td></td>
</tr>
</tbody>
</table>
Load Tray 2 and optional Tray 3

**NOTE:** The procedure to load paper for Tray 3 is the same as for Tray 2. Only Tray 2 is shown here.

1. Pull the tray out and lift up slightly to remove it completely from the product.

2. Pinch the release that is located on the left guide and slide the side guides to the correct paper size.

3. Pinch the release that is located on the rear paper guide and slide it to the correct paper size.
4. Load the paper into the tray. Make sure that the stack is flat at all four corners and that the top of the stack is below the maximum-height indicators.

5. Slide the tray completely into the product.
Use paper output options

Print to the standard output bin

The standard output bin collects paper face-down, in the correct order. Use this bin for most print jobs, including transparencies. To use the standard output bin, be sure that the rear output bin is closed. To avoid jams, do not open or close the rear output bin while the product is printing.

The standard output bin holds up to 250 sheets of 75 g/m² (20 lb) paper.

Print to the rear output bin

The product always prints to the rear output bin if it is open. Paper that is printed to this bin will exit face-up, with the last page on top (reverse order).

The rear output bin holds up to 50 sheets of 75 g/m² (20 lb) paper.

Printing from Tray 1 to the rear output bin provides the straightest path. Opening the rear output bin might improve performance with the following items:

- Envelopes
- Labels
- Small custom-size paper
- Postcards
- Paper heavier than 120 g/m² (32 lb)

To open the rear output bin, grasp the handle at the top of the bin. Pull the bin down to a 45° angle, and slide out the extension.

NOTE: Opening the rear output bin makes the duplexer and the top output bin unavailable. To avoid jams, do not open or close the rear output bin while the product is printing.
3 Parts, supplies, and accessories

- Order parts, accessories, and supplies
- HP policy on non-HP supplies
- HP anticounterfeit Web site
- Print when a toner cartridge is at estimated end of life
- Customer self-repair parts
- Accessories
- Toner cartridge
## Order parts, accessories, and supplies

<table>
<thead>
<tr>
<th>Item</th>
<th>Website</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP original toner cartridges and paper</td>
<td><a href="http://www.hp.com/go/suresupply">www.hp.com/go/suresupply</a></td>
</tr>
<tr>
<td>Order genuine HP parts or accessories</td>
<td><a href="http://www.hp.com/buy/parts">www.hp.com/buy/parts</a></td>
</tr>
<tr>
<td>Order through service or support providers</td>
<td>Contact an HP-authorized service or support provider.</td>
</tr>
</tbody>
</table>
HP policy on non-HP supplies

HP Company cannot recommend the use of non-HP toner cartridges, either new or remanufactured.

**NOTE:** For HP printer products, the use of a non-HP toner cartridge or a refilled toner cartridge does not affect either the warranty to the customer or any HP support contract with the customer. However, if product failure or damage is attributable to the use of a non-HP toner cartridge or refilled toner cartridge, HP will charge its standard time and materials charges to service the product for the particular failure or damage.
HP anticounterfeit Web site

Go to www.hp.com/go/anticounterfeit when you install an HP toner cartridge and the control-panel message says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps to resolve the problem.

Your toner cartridge might not be a genuine HP toner cartridge if you notice the following:

- The supplies status page indicates that a non-HP supply is installed.
- You are experiencing a high number of problems with the toner cartridge.
- The cartridge does not look like it usually does (for example, the packaging differs from HP packaging).
Print when a toner cartridge is at estimated end of life

Black cartridge is low: The product indicates when a toner cartridge level is low. Actual toner cartridge life remaining may vary. Consider having a replacement available to install when print quality is no longer acceptable. The toner cartridge does not need to be replaced now.

Black cartridge is very low: The product indicates when the toner cartridge level is very low. Actual toner cartridge life remaining may vary. Consider having a replacement available to install when print quality is no longer acceptable. The toner cartridge does not need to be replaced now unless the print quality is no longer acceptable.

Once an HP toner cartridge has reached “very low”, HP's Premium Protection Warranty on that toner cartridge has ended.

You can change the way the product reacts when supplies reach the Very Low state. You do not have to re-establish these settings when you install a new toner cartridge.

Enable or disable the Very Low Setting

You can enable or disable the default settings at any time, and you do not have to re-enable them when you install a new toner cartridge.

1. From the Home screen on the product control panel, touch the Setup button.

2. Open the following menus:
   - System Setup
   - Supply Settings
   - Black Cartridge
   - Very Low Setting

3. Select one of the following options:
   - Select the Continue option to set the product to alert you that the toner cartridge is very low, but to continue printing.
   - Select the Stop option to set the product to stop printing (including printing faxes) until you replace the toner cartridge.
   - Select the Prompt option to set the product to stop printing (including printing faxes) and prompt you to replace the toner cartridge. You can acknowledge the prompt and continue printing. A customer configurable option on this product is “Prompt to Remind Me in 100 pages, 200 pages, 300 pages, 400 pages, or never.” This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

When the product is set to the Stop option, there is some risk that faxes will not print after the new cartridge is installed if your product has received more faxes than the memory can hold while stopped.

When the product is set to the Prompt option, there is some risk that faxes will not print after the new cartridge is installed if your product has received more faxes than the memory can hold while the product is waiting for the prompt to be acknowledged.

Once an HP toner cartridge has reached Very Low, HP's Premium Protection Warranty on that toner cartridge has ended. All print defects or cartridge failures incurred when an HP toner cartridge is used in Continue at
very low mode will not be considered to be defects in materials or workmanship in the toner cartridge under the HP Toner Cartridge Warranty Statement.
Customer self-repair parts

The following customer self-repair parts are available for the product.

- Parts listed as **Mandatory** self-replacement are to be installed by customers, unless you are willing to pay HP service personnel to perform the repair. For these parts, on-site or return-to-depot support is not provided under the HP product warranty.

- Parts listed as **Optional** self-replacement can be installed by HP service personnel at your request for no additional charge during the product warranty period.

**NOTE:** For more information, go to [www.hp.com/go/learnaboutsupplies](http://www.hp.com/go/learnaboutsupplies).

### Table 3-1 Customer self-repair parts

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Self-replacement options</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toner cartridge, standard capacity</td>
<td>Replacement toner cartridge</td>
<td>Mandatory</td>
<td>CE255-67901</td>
</tr>
<tr>
<td>Toner cartridge, high capacity</td>
<td>Replacement toner cartridge</td>
<td>Mandatory</td>
<td>CE255-67902</td>
</tr>
<tr>
<td>Tray 2 cassette assembly</td>
<td>Replacement Tray 2</td>
<td>Mandatory</td>
<td>RM1-8512-000CN</td>
</tr>
<tr>
<td>Complete 500 Sheet Feeder (Optional Tray 3)</td>
<td>Optional 500-sheet feeder and installation instructions</td>
<td>Mandatory</td>
<td>CE530-69001</td>
</tr>
<tr>
<td>Document feeder roller maintenance kit</td>
<td>Replacement roller for the document feeder</td>
<td>Optional</td>
<td>A8P79-65001</td>
</tr>
<tr>
<td>Document feeder separation pad</td>
<td>Replacement separation pad for the document feeder</td>
<td>Optional</td>
<td>A8P79-65010</td>
</tr>
<tr>
<td>Power cable 220V-10A</td>
<td>Replacement cable – China</td>
<td>Mandatory</td>
<td>8121-0943</td>
</tr>
<tr>
<td>Power cable 110V-13A</td>
<td>Replacement cable – Taiwan</td>
<td>Mandatory</td>
<td>8121-0964</td>
</tr>
<tr>
<td>Power cable 220V-10A</td>
<td>Replacement cable – Korea, EU Generic</td>
<td>Mandatory</td>
<td>8121-0731</td>
</tr>
<tr>
<td>Power cable 220V-6A</td>
<td>Replacement cable – India</td>
<td>Mandatory</td>
<td>8121-0564</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – UK/Asia Pacific</td>
<td>Mandatory</td>
<td>8121-0739</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – Australia/New Zealand</td>
<td>Mandatory</td>
<td>8121-0837</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – Israel</td>
<td>Mandatory</td>
<td>8121-1004</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – Denmark</td>
<td>Mandatory</td>
<td>8121-0733</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – South Africa</td>
<td>Mandatory</td>
<td>8121-0737</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – Switzerland</td>
<td>Mandatory</td>
<td>8121-0738</td>
</tr>
<tr>
<td>Power cable 110V – 10A</td>
<td>Replacement cable – Brazil</td>
<td>Mandatory</td>
<td>8121-1071</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – Argentina</td>
<td>Mandatory</td>
<td>8121-0729</td>
</tr>
<tr>
<td>Power cable 220V – 10A</td>
<td>Replacement cable – South America/Chile/Peru</td>
<td>Mandatory</td>
<td>8121-0735</td>
</tr>
</tbody>
</table>
### Table 3-1 Customer self-repair parts (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Self-replacement options</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power cable 220 / 110V</td>
<td>Replacement cable – Thailand/Philippines</td>
<td>Mandatory</td>
<td>8121-0734</td>
</tr>
<tr>
<td>Power cable 110V – 10A</td>
<td>Replacement cable – Saudi Arabia/Others</td>
<td>Mandatory</td>
<td>8121-0740</td>
</tr>
</tbody>
</table>
# Accessories

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional 500-sheet tray and feeder unit</td>
<td>Optional tray to increase paper capacity.</td>
<td>CE530A</td>
</tr>
<tr>
<td>MFP Stand</td>
<td>A storage cabinet that is installed beneath the product.</td>
<td>CF338A</td>
</tr>
<tr>
<td>USB cable</td>
<td>2-meter standard USB-compatible device connector</td>
<td>C6518A</td>
</tr>
</tbody>
</table>
Toner cartridge

- Toner-cartridge view
- Toner-cartridge information
- Replace the toner cartridge

**Toner-cartridge view**

1. Imaging drum
   
   **CAUTION:** Do not touch the shutter or the surface of the roller. Doing so can damage the cartridge.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Imaging drum</td>
</tr>
<tr>
<td>2</td>
<td>Memory chip</td>
</tr>
<tr>
<td>3</td>
<td>Pull tab for the sealing tape</td>
</tr>
</tbody>
</table>
### Toner-cartridge information

<table>
<thead>
<tr>
<th>Capacity</th>
<th>Cartridge number</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard-capacity replacement black toner cartridge</td>
<td>55A</td>
<td>CE255A</td>
</tr>
<tr>
<td>High-capacity replacement black toner cartridge</td>
<td>55X</td>
<td>CE255X</td>
</tr>
</tbody>
</table>

For more information about supplies, go to [www.hp.com/go/learnaboutsupplies](http://www.hp.com/go/learnaboutsupplies).

The information contained herein is subject to change without notice. For the latest supplies information go to [www.hp.com/support/ljmfpM521series](http://www.hp.com/support/ljmfpM521series).

### Recycle the toner cartridge

To recycle a genuine HP toner cartridge, place the used cartridge in the box in which the new cartridge arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete information, see the recycling guide that is included with each new HP supply item.

### Toner-cartridge storage

Do not remove the toner cartridge from its package until you are ready to use it.

⚠️ **CAUTION:** To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes.

### HP policy on non-HP toner cartridges

HP Company cannot recommend the use of non-HP toner cartridges, either new or remanufactured.

⚠️ **NOTE:** Any damage caused by a non-HP toner cartridge is not covered under the HP warranty and service agreements.
Replace the toner cartridge

⚠️ **CAUTION:** If toner gets on clothing, wipe it off by using a dry cloth and wash the clothes in cold water. Hot water sets toner into fabric.

📝 **NOTE:** Information about recycling used toner cartridges is on the toner-cartridge box.

1. Press the front-door-release button.

2. Open the front door.
3. Remove the used toner cartridge from the product.

4. Remove the new toner cartridge from the bag. Place the used toner cartridge in the bag for recycling.

5. Grasp the front and back of the toner cartridge, and distribute the toner by gently rocking the toner cartridge five or six times.
   
   **CAUTION:** Do not touch the shutter or the surface of the roller.

6. Remove the sealing tape from the new toner cartridge. Recycle the tape with the used toner cartridge.
7. Align the toner cartridge with the tracks inside the product, and insert the toner cartridge until it is firmly seated.

8. Close the front door.
4 Print

- Supported print drivers (Windows)
- Change print-job settings (Windows)
- Change print-job settings (Mac OS X)
- Print tasks (Windows)
- Print tasks (Mac OS X)
- Create archival-quality prints
- Use HP ePrint
- Use AirPrint
- Use walk-up USB printing
Supported print drivers (Windows)

Print drivers provide access to the product printing system. The following print drivers are available at www.hp.com/go/ljmfpM521series_software.

<table>
<thead>
<tr>
<th>Print Driver</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HP PCL 6 driver</strong></td>
<td>• Provided as the default driver on the in-box CD. This driver is automatically installed unless you select a different one.</td>
</tr>
<tr>
<td></td>
<td>• Recommended for all Windows environments</td>
</tr>
<tr>
<td></td>
<td>• Provides the overall best speed, print quality, and product-feature support for most users</td>
</tr>
<tr>
<td></td>
<td>• Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in Windows environments</td>
</tr>
<tr>
<td></td>
<td>• Might not be fully compatible with third-party and custom software programs that are based on PCL 5</td>
</tr>
<tr>
<td><strong>HP UPD PS driver</strong></td>
<td>• Recommended for printing with Adobe® software programs or with other highly graphics-intensive software programs</td>
</tr>
<tr>
<td></td>
<td>• Provides support for printing from postscript emulation needs, or for postscript flash font support</td>
</tr>
<tr>
<td><strong>HP UPD PCL 5</strong></td>
<td>• Recommended for general office printing in Windows environments</td>
</tr>
<tr>
<td></td>
<td>• Compatible with previous PCL versions and older HP LaserJet products</td>
</tr>
<tr>
<td></td>
<td>• The best choice for printing from third-party or custom software programs</td>
</tr>
<tr>
<td></td>
<td>• The best choice when operating with mixed environments, which require the product to be set to PCL 5 (UNIX, Linux, mainframe)</td>
</tr>
<tr>
<td></td>
<td>• Designed for use in corporate Windows environments to provide a single driver for use with multiple product models</td>
</tr>
<tr>
<td></td>
<td>• Preferred when printing to multiple product models from a mobile Windows computer</td>
</tr>
<tr>
<td><strong>HP UPD PCL 6</strong></td>
<td>• Recommended for printing in all Windows environments</td>
</tr>
<tr>
<td></td>
<td>• Provides the overall best speed, print quality, and printer feature support for most users</td>
</tr>
<tr>
<td></td>
<td>• Developed to align with Windows Graphic Device Interface (GDI) for best speed in Windows environments</td>
</tr>
<tr>
<td></td>
<td>• Might not be fully compatible with third-party and custom software programs that are based on PCL 5</td>
</tr>
</tbody>
</table>

HP Universal Print Driver (UPD)

The HP Universal Print Driver (UPD) for Windows is a single print driver that gives you instant access to virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built on proven HP print driver technology and has been tested thoroughly and used with many software programs. It is a powerful solution that performs consistently over time.

The HP UPD communicates directly with each HP product, gathers configuration information, and then customizes the user interface to show the product’s unique, available features. It automatically enables features that are available for the product, such as two-sided printing and stapling, so you do not need to enable them manually.
For more information, go to www.hp.com/go/upd.

### UPD installation modes

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traditional</td>
<td>To use this mode, download UPD from the Internet. Go to <a href="http://www.hp.com/go/upd">www.hp.com/go/upd</a>.</td>
</tr>
<tr>
<td></td>
<td>Use this mode if you are installing the driver for a single computer.</td>
</tr>
<tr>
<td></td>
<td>It operates with a specific product.</td>
</tr>
<tr>
<td></td>
<td>If you use this mode, you must install UPD separately for each computer and for each product.</td>
</tr>
<tr>
<td>Dynamic</td>
<td>To use this mode, download UPD from the Internet. Go to <a href="http://www.hp.com/go/upd">www.hp.com/go/upd</a>.</td>
</tr>
<tr>
<td></td>
<td>Dynamic mode allows you to use a single driver installation, so you can discover and print to multiple networked HP products in any location.</td>
</tr>
<tr>
<td></td>
<td>Use this mode if you are installing UPD for a workgroup.</td>
</tr>
<tr>
<td></td>
<td>Do not use this mode for USB-connected products.</td>
</tr>
</tbody>
</table>
Change print-job settings (Windows)

- Priority for changing print-job settings
- Change the settings for all print jobs until the software program is closed
- Change the default settings for all print jobs
- Change the product configuration settings

Priority for changing print-job settings

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

- **Page Setup dialog box**: Click Page Setup or a similar command on the File menu of the program you are working in to open this dialog box. Settings changed here override settings changed anywhere else.

- **Print dialog box**: Click Print, Print Setup, or a similar command on the File menu of the program you are working in to open this dialog box. Settings changed in the Print dialog box have a lower priority and usually do not override changes made in the Page Setup dialog box.

- **Printer Properties dialog box (print driver)**: Click Properties in the Print dialog box to open the print driver. Settings changed in the Printer Properties dialog box usually do not override settings anywhere else in the printing software. You can change most of the print settings here.

- **Default print driver settings**: The default print driver settings determine the settings used in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog boxes.

- **Product control-panel settings**: Settings changed at the product control panel have a lower priority than changes made anywhere else.

Change the settings for all print jobs until the software program is closed

The steps can vary; this procedure is most common.

1. From the software program, select the Print option.
2. Select the product, and then click Properties or Preferences.

Change the default settings for all print jobs

1. **Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view)**: Click Start, and then click Printers and Faxes.


**Windows Vista**: Click the Windows icon in the lower-left corner of the screen, click Control Panel, and then click Printers.

**Windows 7**: Click the Windows icon in the lower-left corner of the screen, and then click Devices and Printers.

2. Right-click the print-driver icon for this product, and then select Printing Preferences.
Change the product configuration settings

1. **Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view):**
   Click **Start**, and then click **Printers and Faxes**.

   **Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu view):**
   Click **Start**, click **Settings**, and then click **Printers**.

   **Windows Vista:** Click the Windows icon in the lower-left corner of the screen, click **Control Panel**, and then click **Printers**.

   **Windows 7:** Click the Windows icon in the lower-left corner of the screen, and then click **Devices and Printers**.

2. Right-click the print-driver icon for this product, and then select **Properties** or **Printer properties**.

3. Click the **Device Settings** tab.
Change print-job settings (Mac OS X)

- Priority for changing print-job settings
- Change the settings for all print jobs until the software program is closed
- Change the default settings for all print jobs
- Change the product configuration settings

Priority for changing print-job settings

Changes to print settings are prioritized depending on where the changes are made:

**NOTE:** The names of commands and dialog boxes might vary depending on your software program.

- **Page Setup dialog box:** Click Page Setup or a similar command on the File menu of the program you are working in to open this dialog box. Settings changed here might override settings changed anywhere else.

- **Print dialog box:** Click Print, Print Setup, or a similar command on the File menu of the program you are working in to open this dialog box. Settings changed in the Print dialog box have a lower priority and do not override changes made in the Page Setup dialog box.

- **Default printer driver settings:** The default printer driver settings determine the settings used in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog boxes.

- **Product control-panel settings:** Settings changed at the product control panel have a lower priority than changes made anywhere else.

Change the settings for all print jobs until the software program is closed

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then open a menu for which you want to change the print settings.
4. For each menu, select the print settings that you want to change.
5. Change the settings that you want on the various menus.

Change the default settings for all print jobs

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then open a menu for which you want to change the print settings.
4. For each menu, select the print settings that you want to save for reuse.
5. In the Presets menu, click the Save As... option, and enter a name for the preset.
6. Click the OK button.
These settings are saved in the Presets menu. To use the new settings, you must select the saved preset option every time you open a program and print.

**Change the product configuration settings**

1. At the computer, open the Apple menu, click the **System Preferences** item, and then click the **Print & Fax** icon or the **Print & Scan** icon.
2. Select the product in the left side of the window.
3. Click the **Options & Supplies** button.
4. Click the **Driver** tab.
5. Configure the installed options.
Print tasks (Windows)

- Use a printing shortcut (Windows)
- Create printing shortcuts (Windows)
- Automatically print on both sides (Windows)
- Manually print on both sides (Windows)
- Print multiple pages per sheet (Windows)
- Select the page orientation (Windows)
- Select the paper type (Windows)
- Print the first or last page on different paper (Windows)
- Scale a document to fit page size (Windows)
- Create a booklet (Windows)
- Select the paper size (Windows)
- Select a custom paper size (Windows)
- Print watermarks (Windows)
- Cancel a print job (Windows)

Use a printing shortcut (Windows)

1. From the software program, select the **Print** option.

2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Printing Shortcuts** tab.

4. Select one of the shortcuts. Click the **OK** button to close the **Document Properties** dialog box.

   **NOTE:** When you select a shortcut, the corresponding settings change on the other tabs in the print driver.

5. In the **Print** dialog box, click the **OK** button to print the job.
Create printing shortcuts (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Printing Shortcuts tab.

4. Select an existing shortcut as a base.  
   **NOTE:** Always select a shortcut before adjusting any of the settings on the right side of the screen. If you adjust the settings and then select a shortcut, all your adjustments are lost.
5. Select the print options for the new shortcut.

6. Click the Save As button.
7. Enter a name for the shortcut, and then click the **OK** button.

8. Click the **OK** button to close the **Document Properties** dialog box. In the **Print** dialog box, click the **OK** button to print the job.
Automatically print on both sides (Windows)

The product supports the following paper sizes for automatic duplex printing:

- Letter
- Legal
- A4
- 8.5 x 13

The product supports the following paper types for automatic duplex printing:

- Unspecified
- Plain
- HP EcoSMART Lite
- Light 60–74 g
- Midweight 96–110 g
- Letterhead
- Preprinted
- Prepunched
- Colored
- Bond
- Recycled

For other paper types or sizes, use manual duplex printing.

1. From the software program, select the **Print** option.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Finishing** tab.

4. Select the **Print on both sides** check box. Click the **OK** button to close the **Document Properties** dialog box.

5. In the **Print** dialog box, click the **OK** button to print the job.
Manually print on both sides (Windows)

For paper sizes and types that the automatic duplexer does not support, use manual duplex printing. To use this option, the product must be configured to enable manual duplexing. The first five steps of the following task need to be performed only one time. After that, you can manually print on both sides by starting with step 6.

1. **Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view):** Click **Start**, and then click **Printers and Faxes**.

   **Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu view):** Click **Start**, click **Settings**, and then click **Printers**.

   **Windows Vista:** Click the Windows icon in the lower-left corner of the screen, click **Control Panel**, and then click **Printers**.

   **Windows 7:** Click the Windows icon in the lower-left corner of the screen, and then click **Devices and Printers**.

2. Right-click the print-driver icon, and then select **Printer properties**.

3. Click the **Device Settings** tab.

4. Expand the list of **Installable options**, and in the drop-down list next to **Allow Manual Duplexing:** select **Enabled**.

5. Click the **OK** button.
6. Load Tray 1 with the paper for your document.

7. From the software program, select the **Print** option.

8. Select the product, and then click the **Properties** or **Preferences** button.

9. Click the **Paper/Quality** tab.
10. Select the appropriate paper size for your document, and select the type of paper you are using. In the Paper source drop-down list, select the Manual Feed in Tray 1 option.

11. Click the Finishing tab.

12. Select the Print on both sides (manually) check box. Click the OK button to print the first side of the job.
13. Retrieve the printed stack from the output bin, and place it with the printed-side facing down in Tray 1.

**NOTE:** Do not rotate or turn over the pages.

14. If prompted, touch the appropriate control panel button to continue.
Print multiple pages per sheet (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Finishing tab.

4. Select the number of pages per sheet from the Pages per sheet drop-down list.
5. Select the correct Print page borders, Page order, and Orientation options. Click the OK button to close the Document Properties dialog box.

6. In the Print dialog box, click the OK button to print the job.
Select the page orientation (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Finishing tab.
4. In the Orientation area, select the Portrait or Landscape option.

To print the page image upside down, select the Rotate by 180 degrees option.

Click the OK button to close the Document Properties dialog box.

5. In the Print dialog box, click the OK button to print the job.
Select the paper type (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.
5. Expand the list of **Type is**: options.

6. Expand the category of paper types that best describes your paper.
7. Select the option for the type of paper you are using, and click the OK button.

8. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button to print the job.
Print the first or last page on different paper (Windows)

1. From the software program, select the **Print** option.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Paper/Quality** tab.

4. In the **Special pages** area, click the **Print pages on different paper** option, and then click the **Settings** button.
5. In the **Pages in document** area, select either the **First** or **Last** option.

6. Select the correct options from the **Paper source** and **Paper type** drop-down lists. Click the **Add** button.

7. If you are printing both the first and last pages on different paper, repeat steps 5 and 6, selecting the options for the other page.
8. Click the **OK** button.

9. Click the **OK** button to close the **Document Properties** dialog box. In the **Print** dialog box, click the **OK** button to print the job.
Scale a document to fit page size (Windows)

1. From the software program, select the Print option.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Effects tab.
4. Select the **Print document on** option, and then select a size from the drop-down list.

   Click the **OK** button to close the **Document Properties** dialog box.

5. In the **Print** dialog box, click the **OK** button to print the job.
Create a booklet (Windows)

1. From the software program, select the **Print** option.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Finishing** tab.

4. Select the **Print on both sides** check box.
5. In the Booklet layout drop-down list, click the Left binding or Right binding option. The Pages per sheet option automatically changes to 2 pages per sheet. Click the OK button to close the Document Properties dialog box.

6. In the Print dialog box, click the OK button to print the job.

Select the paper size (Windows)

1. From the software program, select the Print option.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. Select a size from the Paper size drop-down list.
5. Click the OK button.
6. In the Print dialog box, click the OK button to print the job.

Select a custom paper size (Windows)

1. From the software program, select the Print option.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. Click the Custom button.

5. Type a name for the custom size and specify the dimensions.
   - The width is the short edge of the paper.
   - The length is the long edge of the paper.

6. Click the Save button, and then click the Close button.

7. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button to print the job.

Print watermarks (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.
   
   Or, to add a new watermark to the list, click the Edit button. Specify the settings for the watermark, and then click the OK button.

5. To print the watermark on the first page only, select the First page only check box. Otherwise, the watermark is printed on each page.

6. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button to print the job.

Cancel a print job (Windows)

1. If the print job is currently printing, cancel it by pressing the Cancel button on the product control panel.

   **NOTE:** If the print job is too far into the printing process, you might not have the option to cancel it.

   **NOTE:** Pressing the Cancel button clears the job that the product is currently processing. If more than one process is running, pressing the Cancel button clears the process that currently displays on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

   - **Software program:** Typically, a dialog box displays briefly on the computer screen, allowing you to cancel the print job.

   - **Windows print queue:** If a print job is waiting in a print queue (computer memory) or print spooler, delete the job there.
Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and then click Printers and Faxes. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.

Windows Vista: Click the Windows icon in the lower left corner of the screen, click Settings, and then click Printers. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.

Windows 7: Click the Windows icon in the lower left corner of the screen, and then click Devices and Printers. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.
Print tasks (Mac OS X)

- Use a printing preset (Mac OS X)
- Create a printing preset (Mac OS X)
- Automatically print on both sides (Mac OS X)
- Manually print on both sides (Mac OS X)
- Print multiple pages per sheet (Mac OS X)
- Select the page orientation (Mac OS X)
- Select the paper type (Mac OS X)
- Print a cover page (Mac OS X)
- Scale a document to fit page size (Mac OS X)
- Create a booklet (Mac OS X)
- Select the paper size (Mac OS X)
- Select a custom paper size (Mac OS X)
- Print watermarks (Mac OS X)
- Cancel a print job (Mac OS X)

Use a printing preset (Mac OS X)

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. In the Presets menu, select the printing preset.
4. Click the Print button.

NOTE: To use print-driver default settings, select the standard option.

Create a printing preset (Mac OS X)

Use printing presets to save the current print settings for reuse.

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. By default, the print driver displays theCopies & Pages menu. Open the menus drop-down list, and then open a menu for which you want to change the print settings.
4. For each menu, select the print settings that you want to save for reuse.
5. In the Presets menu, click the Save As... option, and enter a name for the preset.
6. Click the OK button.
Automatically print on both sides (Mac OS X)

The product supports the following paper sizes for automatic duplex printing:

- Letter
- Legal
- A4
- 8.5 x 13

The product supports the following paper types for automatic duplex printing:

- Unspecified
- Plain
- HP EcoSMART Lite
- Light 60–74 g
- Midweight 96–110 g
- Letterhead
- Preprinted
- Prepunched
- Colored
- Bond
- Recycled

For other paper types or sizes, use manual duplex printing.

1. Click the **File** menu, and then click the **Print** option.
2. In the **Printer** menu, select the product.
3. By default, the print driver displays the **Copies & Pages** menu. Open the menus drop-down list, and then click the **Layout** menu.
4. Select a binding option from the **Two-Sided** drop-down list.
5. Click the **Print** button.

Manually print on both sides (Mac OS X)

1. Click the **File** menu, and then click the **Print** option.
2. In the **Printer** menu, select this product.
3. By default, the print driver displays the **Copies & Pages** menu. Open the menus drop-down list, and then click the **Manual Duplex** menu.
4. Click the **Manual Duplex** box, and select a binding option.
5. Click the **Print** button.
6. Go to the product, and remove any blank paper that is in Tray 1.

7. Retrieve the printed stack from the output bin and place it with the printed-side facing down in the input tray.

**NOTE:** Do not rotate or turn over the pages.

8. If prompted, touch the appropriate control panel button to continue.

**Print multiple pages per sheet (Mac OS X)**

1. Click the **File** menu, and then click the **Print** option.

2. In the **Printer** menu, select the product.

3. By default, the print driver displays the **Copies & Pages** menu. Open the menus drop-down list, and then click the **Layout** menu.

4. From the **Pages per Sheet** drop-down list, select the number of pages that you want to print on each sheet.

5. In the **Layout Direction** area, select the order and placement of the pages on the sheet.

6. From the **Borders** menu, select the type of border to print around each page on the sheet.

7. Click the **Print** button.

**Select the page orientation (Mac OS X)**

1. Click the **File** menu, and then click the **Print** option.

2. In the **Printer** menu, select the product.

3. In the **Copies & Pages** menu, click the **Page Setup** button.

4. Click the icon that represents the page orientation that you want to use, and then click the **OK** button.

5. Click the **Print** button.

**Select the paper type (Mac OS X)**

1. Click the **File** menu, and then click the **Print** option.

2. In the **Printer** menu, select the product.

3. By default, the print driver displays the **Copies & Pages** menu. Open the menus drop-down list, and then click the **Finishing** menu.

4. Select a type from the **Media-type** drop-down list.

5. Click the **Print** button.

**Print a cover page (Mac OS X)**

1. Click the **File** menu, and then click the **Print** option.

2. In the **Printer** menu, select the product.
3. By default, the print driver displays the **Copies & Pages** menu. Open the menus drop-down list, and then click the **Cover Page** menu.

4. Select where to print the cover page. Click either the **Before Document** button or the **After Document** button.

5. In the **Cover Page Type** menu, select the message that you want to print on the cover page.

   **NOTE:** To print a blank cover page, select the **standard** option from the **Cover Page Type** menu.

6. Click the **Print** button.

### Scale a document to fit page size (Mac OS X)

1. Click the **File** menu, and then click the **Print** option.

2. In the **Printer** menu, select the product.

3. By default, the print driver displays the **Copies & Pages** menu. Open the menus drop-down list, and then click the **Paper Handling** menu.

4. In the **Destination Paper Size** area, click the **Scale to fit paper size** box, and then select the size from the drop-down list.

5. Click the **Print** button.

### Create a booklet (Mac OS X)

1. Click the **File** menu, and then click the **Print** option.

2. In the **Printer** menu, select the product.

3. By default, the print driver displays the **Copies & Pages** menu. Open the menus drop-down list, and then click the **Layout** menu.

4. Select a binding option from the **Two-Sided** drop-down list.

5. Open the menus drop-down list, and then click the **Booklet Printing** menu.

6. Click the **Format Output as Booklet** box, and select a binding option.

7. Select the paper size.

8. Click the **Print** button.

### Select the paper size (Mac OS X)

1. Click the **File** menu, and then click the **Print** option.

2. In the **Printer** menu, select the product.

3. In the **Copies & Pages** menu, click the **Page Setup** button.

4. Select a size from the **Paper Size** drop-down list, and then click the **OK** button.

5. Click the **Print** button.
Select a custom paper size (Mac OS X)

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. In the Copies & Pages menu, click the Page Setup button.
4. From the Paper Size drop-down list, select the Manage Custom Sizes option.
5. Specify the dimensions for the page size, and then click the OK button.
6. Click the OK button to close the Page Setup dialog.
7. Click the Print button.

Print watermarks (Mac OS X)

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then click the Watermarks menu.
4. From the Mode menu, select the Watermark option.
5. From the Pages drop-down list, select whether to print the watermark on all pages or on the first page only.
6. From the Text drop-down list, select one of the standard messages, or select the Custom option and type a new message in the box.
7. Select options for the remaining settings.
8. Click the Print button.

Cancel a print job (Mac OS X)

1. If the print job is currently printing, cancel it by pressing the Cancel button on the product control panel.

   NOTE: If the print job is too far into the printing process, you might not have the option to cancel it.

   NOTE: Pressing the Cancel button clears the job that the product is currently processing. If more than one print job is waiting, pressing the Cancel button clears the print job that currently displays on the product control panel.

2. You can also cancel a print job from a software program or a print queue.
   - Software program: Typically, a dialog box displays briefly on the computer screen, allowing you to cancel the print job.
   - Mac print queue: Open the print queue by double-clicking the product icon in the dock. Highlight the print job, and then click Delete.
Create archival-quality prints

Archive print produces output that is less susceptible to toner smearing and dusting. Use archive print to create documents that you want to preserve or archive.

**NOTE:** Archival-quality printing is accomplished by increasing the temperature of the fuser. Because of the increased temperatures, the product prints at half-speed to avoid damage.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Service menu.
3. Touch the Archive Print button, and then touch the On button.
Use HP ePrint

Use HP ePrint to print documents by sending them as an email attachment to the product's email address from any email enabled device.

**NOTE:** The product must be connected to a wired or wireless network and have Internet access to use HP ePrint.

1. To use HP ePrint, you must first enable HP Web Services.
   a. From the Home screen on the product control panel, touch the Web Services button.
   b. Touch the Enable Web Services button.

2. From the HP Web Services menu, touch the Display E-Mail Address button to display the product’s email address on the control panel.

3. Use the HP ePrintCenter Web site to define security settings and to configure default print settings for all HP ePrint jobs sent to this product.
   b. Click Sign In, and enter your HP ePrintCenter credentials or sign up for a new account.
   c. Select your product from the list, or click + Add printer to add it. To add the product, you need the printer code, which is the segment of the product email address that is before the @ symbol. You can get this code by printing the Web Services page from the product control panel.

   After you have added your product, you will have the option to customize the product email address.

   **NOTE:** This code is valid for only 24 hours from the time you enable HP Web Services. If it expires, follow the instructions to enable HP Web Services again, and obtain a new code.

   d. To prevent your product from printing unexpected documents, click ePrint Settings, and then click the Allowed Senders tab. Click Allowed Senders Only, and add the email addresses from which you want to allow ePrint jobs.

   e. To set up default settings for all ePrint jobs sent to this product, click ePrint Settings, click Print Options, and select the settings that you want to use.

4. To print a document, attach it to an email message sent to the product’s email address. Both the email message and the attachment will print.
Use AirPrint

Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in the following applications:

- Mail
- Photos
- Safari
- Select third-party applications

To use AirPrint, the product must be connected to a network. For more information about using AirPrint and about which HP products are compatible with AirPrint, go to www.hp.com/go/airprint.

**NOTE:** You might need to upgrade the product firmware to use AirPrint. Go to www.hp.com/go/ljmfpM521series_firmware.
Use walk-up USB printing

1. Insert the USB flash drive into the USB port on the front of the product.

2. The USB Flash Drive menu opens. Touch the arrow buttons to scroll through the options.
   - Print Documents
   - View and Print Photos
   - Scan to USB Drive

3. To print a document, touch the Print Documents screen, and then touch the name of the folder on the USB drive where the document is stored. When the summary screen opens, you can touch it to adjust the settings. Touch the Print button to print the document.

4. To print photos, touch the View and Print Photos screen, and then touch the preview image to select each photo that you want to print. Touch the Done button. When the summary screen opens, you can touch it to adjust the settings. Touch the Print button to print the photos.

5. Retrieve the printed job from the output bin, and remove the USB flash drive.
5 Copy

- Set new default copy settings
- Restore copy default settings
- Make a single copy
- Make multiple copies
- Copy a multiple-page original
- Copy identification cards
- Collate a copy job
- Copy on both sides (duplex)
- Reduce or enlarge a copy
- Optimize copy quality
- Adjust the lightness or darkness for copies
- Copy in draft mode
- Set the paper size and type for copying on special paper
Set new default copy settings

You can save any combination of copy settings as the default settings to use for every job.

1. From the Home screen, touch the Copy button.
2. Touch the Settings button.
3. Configure the copy settings to meet your preferences, and then scroll to and touch the Set as New Defaults button.
4. Touch the Yes button.
Restore copy default settings

Use this procedure to restore the factory default copy settings.

1. From the Home screen, touch the Copy button.
2. Touch the Settings button.
3. Scroll to and touch the Restore Defaults button.
4. Touch the OK button to restore the defaults.
Make a single copy

1. Load the document onto the scanner glass or into the document feeder.

   **NOTE:** If documents are in the document feeder and on the scanner glass at the same time, the product processes the document in the document feeder and not the one on the scanner glass.

2. If you loaded the document into the document feeder, adjust the guides until they are snug against the paper.

3. From the Home screen on the product control panel, touch the Copy button.

4. Touch the Start Copy button to start copying.
Make multiple copies

1. Load the document onto the scanner glass or into the document feeder.

   **NOTE:** If documents are in the document feeder and on the scanner glass at the same time, the product processes the document in the document feeder and not the one on the scanner glass.

2. If you loaded the document into the document feeder, adjust the guides until they are snug against the paper.

3. From the Home screen on the product control panel, touch the Copy button.

4. Touch the arrows to change the number of copies, or touch the existing number and enter the number of copies.

5. Touch the Start Copy button to start copying.
Copy a multiple-page original

1. Insert the originals into the document feeder face-up.

2. Adjust the guides until they are snug against the paper.

3. From the Home screen, touch the Copy button.
4. Touch the Start Copy button to start copying.
Copy identification cards

Use the ID Copy feature to copy both sides of identification cards, or other small-size documents, onto the same side of one sheet of paper. The product prompts you to copy the first side and then to place the second side on a different area of the scanner glass and copy again. The product prints both images at the same time.

1. Load the document onto the scanner glass.

2. From the Home screen, touch the Copy button.

3. Touch the ID Copy button.

4. Touch the Start Copy button to start copying.

5. The product prompts you to place the next page on a different section of the scanner glass.

6. Touch the OK button if you have more pages to copy, or touch the Done button if this is the last page.

7. The product copies all pages onto one side of a sheet of paper.
Collate a copy job

1. Load the document onto the scanner glass or into the document feeder.
   
   **NOTE:** If documents are in the document feeder and on the scanner glass at the same time, the product processes the document in the document feeder and not the one on the scanner glass.

2. From the Home screen on the product control panel, touch the Copy button.

3. Touch the Settings button, and then scroll to and touch the Collation button. Touch the arrow buttons to scroll through the options, and then touch an option to select it.

4. Touch the Start Copy button to start copying.
Copy on both sides (duplex)

Copy on both sides automatically

1. Load the original documents into the document feeder with the first page facing up, and with the top of the page leading.

2. Adjust the paper guides to fit the size of the document.

3. From the Home screen on the product control panel, touch the Copy button.

4. Touch the Settings button.

5. Scroll to and touch the Two-Sided button.

6. Touch the arrow buttons to scroll through the options, and then touch an option to select it.

7. Touch the Start Copy button to start copying.
Copy on both sides manually

1. Place the document face-down on the scanner glass with the upper-left corner of the page in the upper-left corner of the glass. Close the scanner.

2. From the Home screen on the product control panel, touch the Copy button.

3. Touch the Settings button.

4. Scroll to and touch the Two-Sided button.

5. Touch the arrow buttons to scroll through the options, and then touch an option to select it.

6. Touch the Start Copy button to start copying.

7. The product prompts you to load the next original document. Place it on the glass, and then touch the OK button.

8. Repeat this process until you have scanned the last page. Touch the Done button to finish printing the copies.
Reduce or enlarge a copy

1. Load the document onto the scanner glass or into the document feeder.
   
   **NOTE:** If documents are in the document feeder and on the scanner glass at the same time, the product processes the document in the document feeder and not the one on the scanner glass.

2. From the Home screen on the product control panel, touch the Copy button.

3. Touch the **Settings** button, and then touch the **Reduce/Enlarge** button. Touch the arrow buttons to scroll through the options, and then touch an option to select it.

4. Touch the **Start Copy** button to start copying.
Optimize copy quality

The following copy-quality settings are available:

- **Auto Select**: Use this setting when you are not concerned about the quality of the copy. This is the default setting.
- **Mixed**: Use this setting for documents that contain a mixture of text and graphics.
- **Text**: Use this setting for documents that contain mostly text.
- **Picture**: Use this setting for documents that contain mostly graphics.

1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen, touch the **Copy** button.

3. Touch the **Settings** button, and then scroll to and touch the **Optimize** button. Touch the arrow buttons to scroll through the options, and then touch an option to select it.

4. Touch the **Start Copy** button to start copying.
Adjust the lightness or darkness for copies

1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen, touch the Copy button.
3. Touch the Settings button.
4. Touch the Lighter/Darker button.
5. Touch the “+” or “-” button to adjust the setting, and then touch the OK button.
6. Touch the Start Copy button to start copying.
Copy in draft mode

Using draft mode can use less toner. However, using draft mode can also reduce print quality.

HP does not recommend the full-time use of draft mode. If draft mode is used full-time, the toner supply might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing the toner cartridge.

1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen, touch the Copy button.
3. Touch the Settings button.
4. Scroll to and touch the Draft Mode button.
5. Touch the On button.
6. Touch the Start Copy button to start copying.
Set the paper size and type for copying on special paper

1. From the Home screen, touch the Copy button.
2. Touch the Settings button, and then scroll to and touch the Paper button.
3. From the list of paper sizes, touch the name of the paper size that is in Tray 1.

   **NOTE:** The product supports these sizes for copying: Letter, Legal, and A4.

4. From the list of paper types, touch the name of the paper type that is in Tray 1.
5. Touch the Start Copy button to start copying.
6  Scan

- Scan by using the HP Scan software (Windows)
- Scan by using the HP Scan software (Mac OS X)
- Scan to a USB flash drive
- Set up scan to network folder and scan to email features
- Scan to a network folder
- Scan to email
- Scan by using other software
Scan by using the HP Scan software (Windows)

1. Double-click the **HP Scan** icon on the computer desktop. If the icon is not on the computer desktop, open the **Programs** folder, click **HP**, open the folder for this product, and then click **HP Scan**.

2. Select a scanning shortcut, and adjust the settings if necessary.

3. Click **Scan**.

**NOTE:** Click **Advanced Settings** to gain access to more options.

Click **Create New Shortcut** to create a customized set of settings and save it in the list of shortcuts.
Scan by using the HP Scan software (Mac OS X)

1. Open the **HP Scan** software, which is located in the **HP** folder inside the **Applications** folder.
2. Follow the on-screen instructions to scan the document.
3. When you have scanned all the pages, click the **Send** button to print the pages or save them to a file.
Scan to a USB flash drive

1. Load the document onto the scanner glass or into the document feeder.
2. Insert a USB flash drive into the port on the front of the product.
3. From the Home screen on the product control panel, touch the Scan button.
4. Touch the Scan to USB Drive screen.
5. Touch the Scan button to scan and save the file. The product creates a folder named HPSCANS on the USB drive, and it saves the file in .PDF or .JPG format using an automatically generated file name.

NOTE: When the summary screen opens, you can touch it to adjust settings.
You also can change the folder name.
Set up scan to network folder and scan to email features

To use these scan features, the product must be connected to a network. These scan features are not available until you configure them. Use the Scan to Network Folder Setup Wizard (Windows) and the Scan to Email Wizard (Windows) at the end of the product software installation process, or use the HP Embedded Web Server to configure these features. The following instructions describe configuring the scan features by using the HP Embedded Web Server.

Configure the scan to network folder feature

1. From the Home screen on the product control panel, touch the Network button to find the product IP address.
2. To open the HP Embedded Web Server, enter the product IP address into the address line of a Web browser.

 NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for Windows or the HP Utility for Mac OS X.

3. Click the Scan tab.
4. Click the Scan to Network Folder Setup link in the left pane of the screen.
5. To set up a new folder, click the New button.
6. Complete the fields on this screen.
7. Click the Save and Test button at the bottom of the screen to save the settings and test the setup.

Configure the scan to email feature

1. From the Home screen on the product control panel, touch the Network button to find the product IP address.
2. To open the HP Embedded Web Server, enter the product IP address into the address line of a Web browser.

 NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for Windows or the HP Utility for Mac OS X.

3. Click the Scan tab.
4. Click the Scan to E-mail Setup link in the left pane of the screen.
5. Click the Outgoing E-mail Profiles link, and then click the New button.
6. Complete the fields on this screen. Ask your network administrator or your Internet service provider for the SMTP Server information. If the SMTP server requires authentication, you also need to know the SMTP User ID and password.
7. Click the Save and Test button at the bottom of the screen to save the settings and test the setup.
8. You can add contacts to the Email Address Book or configure other default Email Settings. These steps are optional. Click the E-mail Address Book link and the E-mail Options links in the left pane of the screen to set up these features.
Scan to a network folder

Use the product control panel to scan a document and save it to a folder on the network.

**NOTE:** In order to use this feature, the product must be connected to a network and the scan feature must be configured using the HP Embedded Web Server.

1. Load the document onto the scanner glass or into the document feeder.
2. From the Home screen on the product control panel, touch the **Scan** button.
3. Touch the **Scan to Network Folder** item.
4. In the list of network folders, select the folder to which you want to save the document.
5. The control panel screen displays the scan settings.
   - If you want to change any of the settings, touch the **Settings** button, and then change the settings.
   - If the settings are correct, go to the next step.
6. Touch the **Scan** button to start the scan job.
Scan to email

Use the product control panel to scan a file directly to an email address. The scanned file is sent to the address as an email message attachment.

**NOTE:** In order to use this feature, the product must be connected to a network and the scan feature must be configured using the HP Embedded Web Server.

1. Load the document onto the scanner glass or into the document feeder.
2. From the Home screen on the product control panel, touch the Scan button.
3. Touch the Scan to E-mail item.
4. Touch the Send an E-mail item.
5. Select the From address that you want to use. This is also known as an “outgoing email profile.”

**NOTE:** If the PIN feature has been set up, enter the PIN and touch the OK button. However, a PIN is not required to use this feature.

6. Touch the To button and pick the address or group to which you want to send the file. Touch the Done button when finished.
7. Touch the Subject button if you would like to add a subject line.
8. Touch the Next button.
9. The control panel screen displays the scan settings.
   - If you want to change any of the settings, touch the Settings button, and then change the settings.
   - If the settings are correct, go to the next step.
10. Touch the Scan button to start the scan job.
Scan by using other software

If you install the full product software, the product is TWAIN-compliant and Windows Imaging Application (WIA)-compliant. If you install the minimum product software, the product is WIA-compliant. The product works with Windows-based programs that support TWAIN-compliant or WIA-compliant scanning devices.

While you are in a TWAIN-compliant or WIA-compliant program, you can gain access to the scanning feature and scan an image directly into the open program. For more information, see the Help file or the documentation that came with your TWAIN-compliant or WIA-compliant software program.

Scan from a TWAIN-compliant program (Windows)

Generally, a software program is TWAIN-compliant if it has a command such as Acquire, File Acquire, Scan, Import New Object, Insert from, or Scanner. If you are unsure whether the program is compliant or you do not know what the command is called, see the software program Help or documentation.

When scanning from a TWAIN-compliant program, the HP Scan software program might start automatically. If the HP Scan program starts, you can make changes while previewing the image. If the program does not start automatically, the image goes to the TWAIN-compliant program immediately.

Start the scan from within the TWAIN-compliant program. See the software program Help or documentation for information about the commands and steps to use.

Scan from a WIA-compliant program (Windows)

WIA is another way to scan an image directly into a software program. WIA uses Microsoft software to scan, instead of the HP Scan software.

Generally, a software program is WIA-compliant if it has a command such as Picture/From Scanner or Camera in the Insert or File menu. If you are unsure whether the program is WIA-compliant, see the software program Help or documentation.

Start the scan from within the WIA-compliant program. See the software program Help or documentation for information about the commands and steps to use.

-Or-

From the Windows control panel, in the Cameras and Scanner folder (located inside the Hardware and Sound folder for Windows Vista and Windows 7), double-click the product icon. This opens the standard Microsoft WIA Wizard, which enables you to scan to a file.
7 Fax

- **Set up the product for fax**
  - Connect the fax port to a telephone line
  - Connect additional devices
    - Set up fax with a telephone answering machine
    - Set up fax with an extension phone
  - Set up for stand-alone fax
  - Configure the fax time, date, and header
    - Use the control panel to set the fax time, date, and header
    - Use the HP Fax Setup Wizard to set the fax time, date, and header (Windows)
- **Use the phone book**
  - Create and edit speed-dial entries
  - Create and edit group-dial entries
  - Delete speed-dial entries
  - Delete group-dial entries
- **Configure send fax settings**
  - Set special dialing symbols and options
    - Set a dialing prefix
  - Set the dial tone detection
    - Tone dial or pulse dial
  - Set autoredial options
  - Set light/dark and resolution
    - Set the default light/dark (contrast) setting
    - Set resolution settings
  - Set billing codes
- **Configure receive fax settings**
  - Set fax forwarding
  - Set the answer mode
  - Block or unblock fax numbers
  - Set the number of rings-to-answer
  - Set distinctive ring
  - Use autoreduction for incoming faxes
  - Set fax reprint settings
  - Set the fax sounds volume
    - Set the alarm volume, phone-line volume, and ring volume
  - Set stamp-received faxes
  - Set the private receive feature

- **Set fax polling**

- **Use fax**
  - Supported fax programs
  - Cancel a fax
    - Cancel the current fax
    - Cancel a pending fax job
  - Delete faxes from memory
  - Use fax on a DSL, PBX, or ISDN system
    - DSL
    - PBX
    - ISDN
  - Use fax on a VoIP service
  - Fax memory contents are retained when there is a loss of power
  - Security issues when connecting internal networks to public phone lines
  - Fax from the flatbed scanner
  - Fax from the document feeder
  - Use speed dials and group-dial entries
  - Send a fax from the software (Windows)
  - Send a fax by dialing from a telephone connected to the fax line
— Send a fax with confirmation
— Schedule a fax to be sent later
— Send a fax combining an electronic and paper document
— Use access codes, credit cards, or calling cards
  ○ Send faxes internationally
— Print a fax
  ○ Reprint a fax
  ○ Automatically print on both sides of received faxes
  ○ Print a stored fax when the private receive feature is on
— Receive faxes when fax tones are audible on the phone line
Set up the product for fax

Connect the fax port to a telephone line

1. Connect the telephone cable to the fax port on the product and to the telephone jack on the wall.

The product is an analog device. HP recommends using the product on a dedicated analog telephone line.

**NOTE:** Some countries/regions might require an adapter to the telephone cable that came with the product.

Connect additional devices

The product includes two fax ports:

- The fax “line in” port, which connects the product to the wall telephone jack.
- The fax “telephone line out” port, which connects additional devices to the product.

Telephones used in conjunction with the product can be employed in two ways:

- An extension phone is connected to the same phone line at another location.
- A downstream phone is connected to the product or to another device that is connected to the product.
Connect additional devices in the order that is described in the following steps. The output port for each device is connected to the input port of the next, forming a "chain". If you do not want to connect a specific device, skip the step that explains it and continue to the next device.

**NOTE:** Do not connect more than three devices to the telephone line.

**NOTE:** Voicemail is not supported with this product.

1. Disconnect the power cords for all of the devices that you want to connect.
2. Connect the product to a telephone jack.
3. Remove the plastic insert from the "telephone line out" port.
4. To connect an internal or external modem on a computer, connect one end of a telephone cord into the product "telephone line out" port. Connect the other end of the telephone cord into the fax "line in" port on the modem or computer.

**NOTE:** Some modems have a second “line” port to connect to a dedicated voice line. If you have two “line” ports, see your modem documentation to make sure that you connect to the correct “line” port.

5. To connect a caller-ID box, connect a telephone cord into the previous device’s “telephone” port. Connect the other end of the telephone cord into the caller-ID box “line” port.
6. To connect an answering machine, connect a telephone cord into the previous device’s “telephone” port. Connect the other end of the telephone cord into the answering machine “line” port.
7. To connect a telephone, connect a telephone cord into the previous device’s “telephone” port. Connect the other end of the telephone cord into the telephone “line” port.
8. After you have finished connecting additional devices, connect all of the devices to their power sources.

**Set up fax with a telephone answering machine**

If you connect a telephone answering machine to the product, follow these steps to configure the product:

**NOTE:** If an answering machine is connected to the same telephone line but on a different jack (in another room, for example), it might interfere with the product’s ability to receive faxes.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup button.
3. Touch the Basic Setup button.
4. Touch the Rings to Answer button.
5. Set the product rings-to-answer setting for at least one ring more than the number of rings for which the answering machine is set. Use the keypad to enter the number of rings, and then touch the OK button.
6. Touch the back button to return to the Basic Setup menu.
7. Scroll to and touch the Answer Mode button.
8. Touch the TAM button. With this setting, the product listens for fax tones after the answering machine has picked up the call. The product picks up a call if fax tones are detected.
**Set up fax with an extension phone**

If you connect an extension phone to the product, follow these steps to configure the product:

1. On the control panel, touch the Setup button.
2. Scroll to and touch the Fax Setup button.
3. Scroll to and touch the Advanced Setup button.
4. Scroll to and touch the Extension Phone button, and confirm that the On option is selected.
   
   With this setting turned on, you can alert the product to pick up the incoming fax call by pressing 1-2-3 sequentially on the telephone keypad. Turn this setting off only if you use pulse dialing or if you have a service from your telephone company that also uses the 1-2-3 sequence. The telephone company service does not work if it conflicts with the product.
5. Touch the back button twice to return to the Fax Setup menu.
6. Touch the Basic Setup button.
7. Scroll to and touch the Answer Mode button.
8. Touch the Fax/Tel button. With this setting, the product automatically picks up all calls and determines if the call is a voice or fax call. If the call is a fax call, the product handles the call as an incoming fax. If the incoming call is detected as a voice call, the product generates an audible synthesized ring to alert you of an incoming voice call.
9. Touch the back button twice to return to the Fax Setup menu.
10. Scroll to and touch the Advanced Setup button.
11. Scroll to and touch the Fax/Tel Ring Time button.
12. Select the number of seconds after which the product should stop sounding the Fax/Tel audible ring to notify you of an incoming voice call.

**Set up for stand-alone fax**

You can use the product as a stand-alone fax machine without connecting it to a computer or a network.

1. Unpack and set up the product.
2. From the Home screen on the product control panel, touch the Setup button.
3. Touch the Fax Setup button.
4. Touch the Fax Set-Up Utility button.
5. Follow the on-screen prompts and select the appropriate response for each question.

   **NOTE:** The maximum number of characters for the fax number is 20.

   **NOTE:** The maximum number of characters for the fax header is 25.

**Configure the fax time, date, and header**

If you did not complete the fax setup process at the time you installed the software, you can complete it at any time by using one of these methods.
Use the control panel to set the fax time, date, and header

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup button.
3. Touch the Basic Setup button.
4. Scroll to and touch the Time/Date button.
5. Select the 12-hour clock or 24-hour clock.
6. Use the keypad to enter the current time, and then touch the OK button.
7. Select the date format.
8. Use the keypad to enter the current date, and then touch the OK button.
9. Touch the Fax Header button.
10. Use the keypad to enter your fax number, and then touch the OK button.

**NOTE:** The maximum number of characters for the fax number is 20.

11. Use the keypad to enter your company name or header, and then touch the OK button.

To enter special characters that are not on the standard keypad, touch the 123 button to open a keypad that contains special characters.

**NOTE:** The maximum number of characters for the fax header is 25.

Use the HP Fax Setup Wizard to set the fax time, date, and header (Windows)

1. Click Start, and then click Programs.
2. Click HP, click the name of the product, and then click HP Fax Setup Wizard.
3. Follow the on-screen instructions in the HP Fax Setup Wizard to configure the fax settings.
Use the phone book

You can store frequently dialed fax numbers (up to 120 entries) as speed-dial entries. Speed-dial entries can be individual fax numbers or groups of fax numbers.

- Create and edit speed-dial entries
- Create and edit group-dial entries
- Delete speed-dial entries
- Delete group-dial entries

Create and edit speed-dial entries

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Phone Book Setup button.
4. Touch the Individual Setup button.
5. Touch an unassigned number from the list.
6. Use the keypad to enter a name for the entry, and then touch the OK button.
7. Use the keypad to enter the fax number for the entry, and then touch the OK button.

Create and edit group-dial entries

1. Create an individual entry for each fax number that you want in the group.
   a. From the Home screen on the product control panel, touch the Fax button.
   b. Touch the Fax Menu button.
   c. Touch the Phone Book Setup button.
   d. Touch the Individual Setup button.
   e. Touch an unassigned number from the list.
   f. Use the keypad to enter a name for the entry, and then touch the OK button.
   g. Use the keypad to enter the fax number for the entry, and then touch the OK button.
2. From the Phone Book Setup menu, touch the Group Setup button.
3. Touch an unassigned number from the list.
4. Use the keypad to enter a name for the group, and then touch the OK button.
5. Touch the name of each individual entry that you want to include in the group. When you are finished, touch the Done Selecting button.
Delete speed-dial entries

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Phone Book Setup button.
4. Touch the Delete Entry button. Or, to delete all the entries, touch the Delete All Entries button.
5. Touch the entry that you want to delete.
6. Touch the OK button to confirm the deletion.

Delete group-dial entries

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Phone Book Setup button.
4. Touch the Delete Entry button. Or, to delete all the entries, touch the Delete All Entries button.
5. Touch the entry that you want to delete.
6. Touch the OK button to confirm the deletion.
Configure send fax settings

- Set special dialing symbols and options
- Set the dial tone detection
- Set autoredial options
- Set light/dark and resolution
- Set billing codes

Set special dialing symbols and options

You can insert pauses into a fax number that you are dialing. Pauses are often needed when dialing internationally or connecting to an outside line.

<table>
<thead>
<tr>
<th>Special symbol</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dialing pause</td>
<td>![Dialing pause icon]</td>
<td>The Redial/Pause button is available on the control panel keypad for entering a fax number. You can also touch the comma button to insert a dialing pause.</td>
</tr>
<tr>
<td>Pause for dial tone</td>
<td>![Pause for dial tone icon]</td>
<td>This character causes the product to wait for a dial tone before dialing the remainder of the telephone number. This button is available only in contexts where it is appropriate.</td>
</tr>
<tr>
<td>Hook flash</td>
<td>![Hook flash icon]</td>
<td>This character causes the product to insert a hook flash. This button is available only in contexts where it is appropriate.</td>
</tr>
</tbody>
</table>

Set a dialing prefix

A dial prefix is a number or group of numbers that are automatically added to the beginning of every fax number you enter at the control panel or from the software. The maximum number of characters for a dial prefix is 50.

The default setting is Off. You might want to turn this setting on and enter a prefix if, for example, you have to dial a number such as 9 to get a telephone line outside of your company telephone system. While this setting is active, you can dial a fax number without the dial prefix by using manual dial.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Basic Setup menu.
4. Scroll to and touch the Dial Prefix button, and then touch the On button.
5. Use the keypad to enter the prefix, and then touch the OK button. You can use numbers, pauses, and dialing symbols.

Set the dial tone detection

Normally, the product begins dialing a fax number immediately. If you are using the product on the same line as your telephone, turn on the detect-dial-tone setting. This prevents the product from sending a fax while someone is on the telephone.
The factory-set default for detect dial tone is On for France and Hungary, and Off for all other countries/regions.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Scroll to and touch the Detect Dial Tone button, and then touch the On or Off button.

**Tone dial or pulse dial**

Use this procedure to set the product to tone-dialing or pulse-dialing mode. The factory-set default is Tone. Do not change this setting unless you know that the telephone line cannot use tone dialing.

NOTE: The pulse-dialing option is not available in all countries/regions.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Scroll to and touch the Dialing Mode button, and then touch the Tone or Pulse button.

**Set autoredial options**

If the product was unable to send a fax because of a communication error or the receiving fax machine did not answer or was busy, the product attempts to redial based on the redial-on-busy, redial-on-no-answer, and redial-on-communication-error options.

**Set the redial-on-busy option**

If this option is on, the product redials automatically if it receives a busy signal. The factory-set default for the redial-on-busy option is On.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Scroll to and touch the Redial if Busy button, and then touch the On or Off button.

**Set the redial-on-no-answer option**

If this option is on, the product redials automatically if the receiving machine does not answer. The factory-set default for the redial-on-no-answer option is Off.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Scroll to and touch the Redial if No Answer button, and then touch the On or Off button.
Set the redial-on-communication-error option

If this option is on, the product redials automatically if some sort of communication error occurs. The factory-set default for the redial-on-communication-error option is On.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Scroll to and touch the Redial if Comm. Error button, and then touch the On or Off button.

Set light/dark and resolution

Set the default light/dark (contrast) setting

The contrast affects the lightness and darkness of an outgoing fax as it is being sent.

The default light/dark setting is the contrast that is normally applied to items that are being faxed. The slider is set to the middle as the default setting.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Touch the Lighter/Darker button, and then touch one of the arrows to adjust the slider.

Set resolution settings

**NOTE:** Increasing the resolution increases the fax file size. Larger faxes increase the send time and could exceed the available memory in the product.

The following settings are available:

- **Standard:** This setting provides the lowest quality and the fastest transmission time.
- **Fine:** This setting provides a higher resolution quality than Standard that is usually appropriate for text documents.
- **Superfine:** This setting is best used for documents that mix text and images. The transmission time is slower than the Fine setting but faster than the Photo setting.
- **Photo:** This setting produces the best images, but greatly increases the transmission time.

Set the fax resolution for the current fax job

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Send Options button.
4. Touch the Fax Resolution button, and then touch one of the options.

**NOTE:** The factory-set default resolution setting is Fine.
Set the default resolution setting for all fax jobs

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Touch the Fax Resolution button, and then touch one of the options.

NOTE: The factory-set default resolution setting is Fine.

Set billing codes

If the billing codes feature is on, the product prompts you to enter a billing code for each fax. The product increases the billing code count for each sent fax page. This includes all types of faxes except for poll-received, fax-forwarded, or computer-downloaded faxes. For an undefined group or a group-dial fax, the product increases the billing code count for each successful fax that is sent to each destination.

The factory-set default for the billing-code setting is Off. The billing code can be any number from 1 through 250.

Set the billing-code setting

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Scroll to and touch the Billing Codes button, and then touch the On button.

Use billing codes

1. Load the document in the document feeder or on the scanner glass.
2. From the Home screen on the product control panel, touch the Fax button.
3. Enter the fax number, or select a speed-dial or group-dial entry.
4. Touch the Start Fax button.
5. Enter the billing code, and then touch the OK button.

Print the billing-code report

The billing-code report is a printed list of all the fax billing codes and the total number of faxes billed to each code. This report is available only when the billing code feature is on.

NOTE: After the product prints this report, it deletes all billing data.

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Fax Reports button.
4. Scroll to and touch the Print Billing Report button.
Configure receive fax settings

- **Set fax forwarding**
- **Set the answer mode**
- **Block or unblock fax numbers**
- **Set the number of rings-to-answer**
- **Set distinctive ring**
- **Use autoreduction for incoming faxes**
- **Set fax reprint settings**
- **Set the fax sounds volume**
- **Set stamp-received faxes**
- **Set the private receive feature**

**Set fax forwarding**

You can set your product to forward incoming faxes to another fax number. When the fax arrives at your product, it is stored in the memory. The product then dials the fax number that you have specified and sends the fax. If the product cannot forward a fax because of an error (for example, the number is busy) and repeated redial attempts are unsuccessful, your product prints the fax.

If the product runs out of memory while receiving a fax, it terminates the incoming fax and only forwards the pages and partial pages that have been stored in the memory.

When it is using the fax-forwarding feature, the product (rather than the computer) must be receiving the faxes, and the answer mode must be set to **Automatic**.

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Receive Options button.
4. Touch the Forward Fax button, and touch the On button.
5. Use the keypad to enter the fax-forwarding number, and then touch the OK button.

**Set the answer mode**

Depending on the situation, set the product answer mode to **Automatic**, **TAM**, **Fax/Tel**, or **Manual**. The factory-set default is **Automatic**.

- **Automatic**: The product answers incoming calls after a specified number of rings or upon recognition of special fax tones.
- **TAM**: The product does not automatically answer the call. Instead, it waits until it detects the fax tone.
Fax/Tel: The product answers incoming calls immediately. If it detects the fax tone, it processes the call as a fax. If it does not detect the fax tone, it creates an audible ring to alert you to answer the incoming voice call.

Manual: The product never answers calls without intervention. You must start the fax-receiving process yourself, either by touching the Start Fax button on the control panel or by picking up a telephone that is connected to that line and dialing 1-2-3.

To set or change the answer mode, complete the following steps:

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Basic Setup menu.
4. Scroll to and touch the Answer Mode button, and then touch the name of the option that you want to use.

Block or unblock fax numbers

If you do not want to receive faxes from specific people or businesses, you can block as many as 30 fax numbers by using the control panel. When you block a fax number and someone from that number sends you a fax, the control-panel display indicates that the number is blocked, the fax does not print, and the fax is not saved in memory. Faxes from blocked fax numbers appear in the fax activity log with a “discarded” designation. You can unblock blocked fax numbers individually or all at one time.

NOTE: The sender of a blocked fax is not notified that the fax failed.

NOTE: If the sender has not configured the fax header, the number cannot be blocked.

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Receive Options button.
4. Touch the Block Junk Faxes button.
5. Touch the Add Number button.
6. Use the keypad to enter the fax number that you want to block, and then touch the OK button.

Set the number of rings-to-answer

When the answer mode is set to Automatic, the product rings-to-answer setting determines the number of times the telephone rings before the product answers an incoming call.

If the product is connected to a line that receives both fax and voice calls (a shared line) and that also uses an answering machine, you might need to adjust the rings-to-answer setting. The number of rings-to-answer for the product must be greater than the rings-to-answer on the answering machine. This allows the answering machine to answer the incoming call and record a message if it is a voice call. When the answering machine answers the call, the product listens to the call and automatically answers it if it detects fax tones.

The default setting for rings-to-answer is varies by country/region.

Use the following table to determine the number of rings-to-answer to use.
<table>
<thead>
<tr>
<th>Type of telephone line</th>
<th>Recommended rings-to-answer setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dedicated fax line (receiving only fax calls)</td>
<td>Set to a number of rings within the range shown on the control-panel display. (The minimum and maximum number of rings allowed varies by country/region.)</td>
</tr>
<tr>
<td>One line with two separate numbers and a ring-pattern service</td>
<td>One or two rings. (If you have an answering machine or computer voicemail for the other telephone number, make sure that the product is set to a greater number of rings than the answering system. Also, use the distinctive-ring feature to differentiate between voice and fax calls.)</td>
</tr>
<tr>
<td>Shared line (receiving both fax and voice calls) with only an attached telephone</td>
<td>Five rings or more.</td>
</tr>
<tr>
<td>Shared line (receiving both fax and voice calls) with an attached answering machine</td>
<td>Two rings more than the answering machine or computer voicemail.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To set or change the number of rings-to-answer, use the following steps:

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Basic Setup menu.
4. Touch the Rings to Answer button.
5. Use the keypad to enter the number of rings, and then touch the OK button.

**Set distinctive ring**

Ring-pattern or distinctive-ring service is available through some local telephone companies. The service provides a way to have more than one telephone number on a single line. Each telephone number has a unique ring pattern, so that you can answer voice calls and the product can answer fax calls.

If you subscribe to a ring-pattern service with a telephone company, you must set the product to answer the correct ring pattern. Not all countries/regions support unique ring patterns. Contact the telephone company to determine if this service is available in your country/region.

**NOTE:** If you do not have ring-pattern service and you change the ring-pattern settings to something other than the default, All Rings, the product might not be able to receive faxes.

The settings are as follows:

- **All Rings:** The product answers any calls that come through the telephone line.
- **Single:** The product answers any calls that produce a single-ring pattern.
- **Double:** The product answers any calls that produce a double-ring pattern.
- **Triple:** The product answers any calls that produce a triple-ring pattern.
- **Double and Triple:** The product answers any calls that produce a double-ring or triple-ring pattern.
To change ring patterns for call answering, complete the following steps:

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Basic Setup menu.
4. Touch the Distinctive Ring button, and then touch the name of an option.

**Use autoreduction for incoming faxes**

If the fit-to-page option is turned on, the product automatically reduces long faxes up to 75% to fit the information on the default paper size (for example, the fax is reduced from legal to letter size).

If the fit-to-page option is turned off, long faxes print at full size on multiple pages. The factory-set default for incoming fax autoreduction is On.

If you have the Stamp Faxes option turned on, you might also want to turn on autoreduction. This reduces the size of the incoming faxes slightly, and prevents the page-stamp from forcing a fax onto two pages.

**NOTE:** Make sure that the default paper size setting matches the size of the paper in the tray.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Touch the Fit to Page button, and then touch the On button.

**Set fax reprint settings**

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Scroll to and touch the Allow Fax Reprint button, and then touch the On button.

After this feature is turned on, a Reprint Faxes button is available in the Fax Menu > Receive Options menu.

**Set the fax sounds volume**

Use this setting to control the volume of the fax sounds from the control panel. You can make changes to the following sounds:

- Alarm Volume
- Ring Volume
- Phone Line Volume
Set the alarm volume, phone-line volume, and ring volume

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the System Setup menu.
3. Touch the Volume Settings menu.
4. Touch the name of the volume setting that you want to adjust, and then touch one of the options. Repeat this step for each volume setting.

Set stamp-received faxes

The product prints the sender identification information at the top of each received fax. You can also stamp the incoming fax with your own header information to confirm the date and time that the fax was received. The factory-set default for stamp-received faxes is Off.

**NOTE:** Turning on the stamp-received setting might increase the page size and cause the product to print a second page.

**NOTE:** This option applies only to received faxes that the product prints.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Scroll to and touch the Stamp Faxes button, and then touch the On button.

Set the private receive feature

When the private-receive feature is active, received faxes are stored in memory and not printed. A password is required to print the stored faxes.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Scroll to and touch the Private Receive button, and then touch the On button.
5. If you have not already set a system password, the product prompts you to create one.

**NOTE:** The system password is case-sensitive.

a. Touch the OK button, and then use the keypad to enter the system password.

b. Touch the OK button, confirm the password by entering it a second time, and then touch the OK button to save the password.

After this feature is turned on, a Print Private Faxes button is available in the Fax Menu > Receive Options menu.
Set fax polling

If someone else has set up a fax to be polled, you can request that the fax be sent to your product. (This is known as polling another machine).

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Receive Options button.
4. Touch the Polling Receive button.
5. Use the keypad on the touchscreen to enter the number of the fax machine that you want to poll, and then touch the OK button.

The product dials the other fax machine and requests the fax.
Use fax

- Supported fax programs
- Cancel a fax
- Delete faxes from memory
- Use fax on a DSL, PBX, or ISDN system
- Use fax on a VoIP service
- Fax memory contents are retained when there is a loss of power
- Security issues when connecting internal networks to public phone lines
- Fax from the flatbed scanner
- Fax from the document feeder
- Use speed dials and group-dial entries
- Send a fax from the software (Windows)
- Send a fax by dialing from a telephone connected to the fax line
- Send a fax with confirmation
- Schedule a fax to be sent later
- Send a fax combining an electronic and paper document
- Use access codes, credit cards, or calling cards
- Print a fax
- Receive faxes when fax tones are audible on the phone line

Supported fax programs

The PC fax program that came with the product is the only PC fax program that works with the product. To continue to use a PC fax program previously installed on the computer, use the modem that is already connected to the computer; it will not function through the product modem.

Cancel a fax

Use these instructions to cancel a single fax that is currently dialing or a fax that is being transmitted or received.

Cancel the current fax

Press the Cancel button on the control panel. Any pages that have not been transmitted are canceled. Pressing the Cancel button also stops group-dial jobs.

Cancel a pending fax job

Use this procedure to cancel a fax job in the following situations:
• The product is waiting to redial after encountering a busy signal, an unanswered call, or a communication error.

• The fax is scheduled to be sent at a future time.

Use the following steps to cancel a fax job by using the Fax Job Status menu:

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Send Options button.
4. Touch the Fax Job Status button.
5. Touch the fax number for the job that you want to cancel.

Delete faxes from memory

Use this procedure only if you are concerned that someone else has access to your product and might try to reprint faxes from the memory.

⚠️ CAUTION: In addition to clearing the reprint memory, this procedure clears any fax that is currently being sent, unsent faxes that are pending redial, faxes that are scheduled to be sent at a future time, and faxes that are not printed or forwarded.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Service menu.
3. Touch the Fax Service menu.
4. Touch the Clear Saved Faxes button.

Use fax on a DSL, PBX, or ISDN system

HP products are designed specifically for use with traditional analog phone services. They are not designed to work on DSL, PBX, ISDN lines, or VoIP services, but they work with the proper setup and equipment.

NOTE: HP recommends discussing DSL, PBX, ISDN, and VoIP setup options with the service provider.

The HP LaserJet product is an analog device that is not compatible with all digital phone environments (unless a digital-to-analog converter is used). HP does not guarantee that the product will be compatible with digital environments or digital-to-analog converters.

DSL

A digital subscriber line (DSL) uses digital technology over standard copper telephone wires. This product is not directly compatible with those digital signals. However, if the configuration is specified during DSL setup, the signal can be separated so that some of the bandwidth is used to transmit an analog signal (for voice and fax) while the remaining bandwidth is used to transmit digital data.

NOTE: Not all faxes are compatible with DSL services. HP does not guarantee that the product will be compatible with all DSL service lines or providers.

A typical DSL modem employs a filter to separate the higher frequency DSL modem communication from lower frequency analog phone and fax modem communication. It is often necessary to use a filter with
analog phones and analog fax products that are connected to a telephone line used by a DSL modem. The DSL service provider usually provides this filter. Contact the DSL provider for more information or for assistance.

**PBX**

The product is an analog device that is not compatible in all digital phone environments. Digital-to-analog filters or converters may be needed for faxing functionality. If faxing issues occur in a PBX environment, it might be necessary to contact the PBX provider for assistance. HP does not guarantee that the product will be compatible with digital environments or digital-to-analog converters.

Contact the PBX provider for more information and for assistance.

**ISDN**

The product is an analog device that is not compatible in all digital phone environments. Digital-to-analog filters or converters may be needed for faxing functionality. If faxing issues occur in an ISDN environment, it might be necessary to contact the ISDN provider for assistance. HP does not guarantee that the product will be compatible with ISDN digital environments or digital-to-analog converters.

**Use fax on a VoIP service**

Voice over internet protocol (VoIP) services are often not compatible with fax machines unless the provider explicitly states that it supports fax over IP services.

If the product experiences problems getting a fax to work on a VoIP network, verify that all cables and settings are correct. Decreasing the fax-speed setting might allow the product to send a fax over a VoIP network.

If the VoIP provider offers a "Pass through" mode for the connection, that will offer better fax performance on VoIP. Also if the provider has "comfort noise" added to the line, fax performance can be enhanced if this feature is not enabled.

If faxing problems continue, contact the VoIP provider.

**Fax memory contents are retained when there is a loss of power**

The flash memory protects against data loss when a power failure occurs. Other fax devices store fax pages in either normal RAM or short-term RAM. Normal RAM immediately loses data when power is lost, while short-term RAM loses data about 60 minutes after a power failure occurs. Flash memory can maintain its data for years without power applied.

**Security issues when connecting internal networks to public phone lines**

The product can send and receive fax data over telephone lines that conform to public switch telephone network (PSTN) standards. The secure fax protocols make it impossible for computer viruses to be transferred from the telephone line to a computer or network.

The following product features prevent virus transmission:
- No direct connection exists between the fax line and any devices that are connected to the USB or Ethernet ports.
- The internal firmware cannot be modified through the fax connection.
- All fax communications go through the fax subsystem, which does not use Internet data-exchange protocols.

**Fax from the flatbed scanner**

1. Place the document face-down on the scanner glass.
   
   **NOTE:** If documents are in the document feeder and on the scanner glass at the same time, the product processes the document in the document feeder and not the one on the scanner glass.

2. From the Home screen on the product control panel, touch the *Fax* button.

3. Use the keypad to enter the fax number.

4. Touch the *Start Fax* button.

5. The product prompts you to confirm that you are sending from the scanner glass. Touch the *Yes* button.

6. The product prompts you to load the first page. Touch the *OK* button.

7. The product scans the first page and then prompts you to load another page. If the document has multiple pages, touch the *Yes* button. Continue this process until you have scanned all the pages.

8. When you have scanned the last page, touch the *No* button at the prompt. The product sends the fax.
Fax from the document feeder

1. Insert the originals into the document feeder face-up.

   **NOTE:** The document feeder capacity is up to 50 sheets of 75 g/m² (20 lb) paper.

   **CAUTION:** To prevent damage to the product, do not use an original that contains correction tape, correction fluid, paper clips, or staples. Also, do not load photographs, small originals, or fragile originals into the document feeder.

   **NOTE:** If documents are in the document feeder and on the scanner glass at the same time, the product processes the document in the document feeder and not the one on the scanner glass.

2. Adjust the paper guides until they are snug against the paper.

3. From the Home screen on the product control panel, touch the Fax button.

4. Use the keypad to enter the fax number.

5. Touch the Start Fax button.

Use speed dials and group-dial entries

1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen on the product control panel, touch the Fax button.
3. On the keypad, touch the fax phone book icon.

4. Touch the name of the individual or group entry that you want to use.

5. Touch the Start Fax button.

Send a fax from the software (Windows)

The following information provides basic instructions for sending faxes by using the software that came with the product. All other software-related topics are covered in the software Help, which can be opened from the software-program Help menu.

You can fax electronic documents from a computer if you meet the following requirements:

- The product is connected directly to the computer or to a network to which the computer is connected.
- The product software is installed on the computer.
- The computer operating system is one that this product supports.

Send a fax from the software

The procedure to send a fax varies according to your specifications. The most typical steps follow.

1. Click Start, click Programs (or All Programs in Windows XP), and then click HP.
2. Click the product name, and then click HP Send fax. The fax software opens.
3. Enter the fax number of one or more recipients.
4. Load the document in the document feeder.
5. Click Send Now.

Send a fax from a third-party software program, such as Microsoft Word

1. Open a document in a third-party program.
2. Click the File menu, and then click Print.
3. Select the fax print driver from the print driver drop-down list. The fax software opens.
4. Enter the fax number of one or more recipients.
5. Include any pages loaded at the product. This step is optional.
6. Click Send Now.
Send a fax by dialing from a telephone connected to the fax line

Occasionally, you might want to dial a fax number from a telephone that is connected to the same line as the product. For example, if you are sending a fax to a person whose device is in the manual receive mode, you can precede the fax with a voice call to let that person know that the fax is coming.

**NOTE:** The telephone must be connected to the product “telephone” port.

1. Load the document into the document feeder.

2. From the Home screen on the product control panel, touch the Fax button.

3. Pick up the handset of a telephone that is connected to the same line as the product. Dial the fax number by using the telephone keypad.

4. When the recipient answers, instruct the person to start the fax machine.

5. When you hear the fax tones, touch the Start Fax button on the control panel, wait until the control panel displays the **Connecting** message, and then hang up the telephone.

Send a fax with confirmation

You can set the product so that it prompts you to enter the fax number a second time to confirm that you are sending the fax to the correct number.

1. From the Home screen on the product control panel, touch the Setup button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Confirm Fax Number button, and touch the On button.

5. Send the fax.

Schedule a fax to be sent later

Use the product control panel to schedule a fax to be sent automatically at a future time to one or more people. When this procedure is completed, the product scans the document into memory and then returns to the Ready state.

**NOTE:** If the product cannot transmit the fax at the scheduled time, that information is indicated on the fax error report (if that option is turned on) or recorded in the fax activity log. The transmittal might not be initiated because the fax-sending call is not answered, or because a busy signal stops the redial attempts.

If a fax has been scheduled to be sent at a future time but it requires updating, send the additional information as another job. All faxes that are scheduled to go to the same fax number at the same time are delivered as individual faxes.
1. Load the document into the document feeder.

2. From the Home screen on the product control panel, touch the Fax button.

3. Touch the Fax Menu button.

4. Touch the Send Options button.

5. Touch the Send Fax Later button.

6. Use the keypad to enter the time of day to send the fax. Touch the OK button.

7. Use the keypad to enter the date to send the fax. Touch the OK button.

8. Use the keypad to enter the fax number. Touch the OK button. The product scans the document and saves it in memory until the designated time.

**Send a fax combining an electronic and paper document**

Use the HP Send Fax software to set up this feature. To start the software program, from the Windows Start menu, navigate to the program group for this product, and then click the HP Send Fax item. Use the software to combine the documents into a single fax job.

**Use access codes, credit cards, or calling cards**

To use access codes, credit cards, or calling cards, dial manually to allow for pauses and dialing codes.

**Send faxes internationally**

To send a fax to an international destination, dial manually to allow for pauses and international dialing codes.
Print a fax

When the product receives a fax transmission, it prints the fax (unless the private-receive feature is enabled) and also stores it automatically to flash memory.
Reprint a fax

When the Allow Fax Reprint feature is on, the product stores received faxes in memory. The product has about 3.2 MB of storage space, which holds about 250 pages.

These faxes are stored continuously. Reprinting them does not clear them from the memory.

The default setting for this feature is Off.

Turn on the Allow Fax Reprint feature

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Scroll to and touch the Allow Fax Reprint button, and touch the On button.

Reprint faxes

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Receive Options button.
4. Touch the Reprint Faxes button.
Automatically print on both sides of received faxes

Use the product control panel to configure the product to print two-sided copies of received faxes.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup button.
3. Touch the Advanced Setup button.
4. Touch the Print Duplex button.
5. Touch the On button.

Print a stored fax when the private receive feature is on

To use this feature, you must enable the Private Receive feature on the product. Use the following procedure to enable this feature.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup button.
3. Touch the Advanced Setup button.
4. Scroll to and touch the Private Receive button.
5. Touch the On button.

To print stored faxes, you must provide the product security password. After the product prints the stored faxes, the faxes are deleted from memory.

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Receive Options button.
4. Touch the Print Private Faxes button.
5. Use the keypad on the touchscreen to enter the product security password, and then touch the OK button.

Receive faxes when fax tones are audible on the phone line

If you have a telephone line that receives both fax and telephone calls, and you hear fax tones when you answer the telephone, you can start the receiving process in one of two ways:

- Touch the Start Fax button on the product control panel.
- Press 1-2-3 in sequence on the telephone keypad, listen for fax transmission sounds, and then hang up.

**NOTE:** For the second method to work, the Extension Phone option must be turned on. This option is one of the Advanced Setup options in the Fax Setup menu.
8 Manage and maintain

- Use the HP Reconfiguration Utility to change the product connection (Windows)
- Set up HP Wireless Direct Printing
- Use HP Web Services applications
- Configure IP network settings
- HP Device Toolbox (Windows)
- HP Utility for Mac OS X
- Use HP Web Jetadmin software
- Economy settings
- Product security features
- Upgrade the firmware
Use the HP Reconfiguration Utility to change the product connection (Windows)

If you are already using the product and you wish to change the way it is connected, use the HP Reconfiguration Utility to set up the connection. For example, you can reconfigure the product to use a different wireless address, to connect to a wired or wireless network, or change from a network connection to a USB connection. You can change the configuration without inserting the product CD. After you select the type of connection you wish to make, the program goes directly to the portion of the product setup procedure that needs to change.

The HP Reconfiguration Utility is located in the HP programs group on your computer.
Set up HP Wireless Direct Printing

**NOTE:** This feature is available with wireless models only.

The HP Wireless Direct Printing feature lets you print from your wireless mobile device directly to an HP Wireless Direct–enabled product without requiring connection to an established network or the Internet. Use HP Wireless Direct to print wirelessly from the following devices:

- iPhone, iPad, or iTouch using Apple AirPrint
- Mobile devices that run Android, iOS, or Symbian using the HP ePrint Home & Biz application

To set up HP Wireless Direct from the control panel, complete the following steps:

**NOTE:** This feature requires you to set up a security password for the product. If you have not previously configured a password, you are prompted to configure one after you enable the feature.

1. From the Home screen on the product control panel, touch the Wireless button.
2. Open the following menus:
   - Wireless Menu
   - Wireless Direct Settings
   - On/Off

**NOTE:** If the Wireless Direct Settings item does not appear on the control panel, you need to upgrade the product firmware. To get the current version, go to www.hp.com, enter the HP product number in the search box, select the specific product model, and then click the Software & Driver Downloads link.

3. Touch the On menu item. The product might prompt you to set a security password. The product saves the setting and then returns the control panel to the Wireless Direct Settings menu.
Use HP Web Services applications

1. From the Home screen on the product control panel, touch the Web Services button.

2. Touch the Enable Web Services button.

After you download an application from the HP ePrintCenter Web site, it is available in the Apps menu on the product control panel. This process enables both HP Web Services and the Apps menu.
Configure IP network settings

- Printer sharing disclaimer
- View or change network settings
- Manually configure IPv4 TCP/IP parameters from the control panel
- Rename the product on a network
- Link speed and duplex settings

Printer sharing disclaimer

HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

View or change network settings

Use the HP Embedded Web Server to view or change IP configuration settings.

1. From the Home screen on the product control panel, touch the Network button to find the product IP address.
2. To open the HP Embedded Web Server, enter the IP address into the address line of a Web browser.

   **NOTE:** You can also access the HP Embedded Web Server from the HP Device Toolbox for Windows or the HP Utility for Mac OS X.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Manually configure IPv4 TCP/IP parameters from the control panel

Use the control-panel menus to manually set an IPv4 address, subnet mask, and default gateway.

1. From the Home screen on the product control panel, touch the Setup button.
2. Scroll to and touch the Network Setup menu.
3. Touch the TCP/IP Config menu, and then touch the Manual button.
4. Use the keypad on the touchscreen to enter the IP address, and touch the OK button. Touch the Yes button to confirm.
5. Use the keypad on the touchscreen to enter the subnet mask, and touch the OK button. Touch the Yes button to confirm.
6. Use the keypad on the touchscreen to enter the default gateway, and touch the OK button. Touch the Yes button to confirm.

Rename the product on a network

If you want to rename the product on a network so that it can be uniquely identified, use the HP Embedded Web Server.
1. From the Home screen on the product control panel, touch the Network button to find the product IP address.

2. To open the HP Embedded Web Server, enter the product IP address into the address line of a Web browser.

   **NOTE:** You can also access the HP Embedded Web Server from the HP Device Toolbox for Windows or the HP Utility for Mac OS X.

3. Open the System tab.

4. On the Device Information page, the default product name is in the Device Status field. You can change this name to uniquely identify this product.

   **NOTE:** Completing the other fields on this page is optional.

5. Click the Apply button to save the changes.
Link speed and duplex settings

**NOTE:** This information applies only to Ethernet networks. It does not apply to wireless networks.

The link speed and communication mode of the print server must match the network hub. For most situations, leave the product in automatic mode. Incorrect changes to the link speed and duplex settings might prevent the product from communicating with other network devices. If you need to make changes, use the product control panel.

**NOTE:** The setting must match with the network product to which you are connecting (a network hub, switch, gateway, router, or computer).

**NOTE:** Making changes to these settings causes the product to turn off and then on. Make changes only when the product is idle.

1. From the Home screen on the product control panel, touch the Setup button.
2. Scroll to and touch the Network Setup menu.
3. Touch the Link Speed menu.
4. Select one of the following options.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>The print server automatically configures itself for the highest link speed and communication mode allowed on the network.</td>
</tr>
<tr>
<td>10T Full</td>
<td>10 Mbps, full-duplex operation</td>
</tr>
<tr>
<td>10T Half</td>
<td>10 megabytes per second (Mbps), half-duplex operation</td>
</tr>
<tr>
<td>100TX Full</td>
<td>100 Mbps, full-duplex operation</td>
</tr>
<tr>
<td>100TX Half</td>
<td>100 Mbps, half-duplex operation</td>
</tr>
<tr>
<td>1000T Full</td>
<td>1000 Mbps, full-duplex operation</td>
</tr>
</tbody>
</table>

5. Touch the OK button. The product turns off and then on.
**HP Device Toolbox (Windows)**

Use the HP Device Toolbox for Windows to check product status or to view or change product settings from your computer. This tool opens the HP Embedded Web Server for the product.

**NOTE:** This tool is available only if you performed a full installation when you installed the product. Depending on how the product is connected, some features might not be available.

1. Click the **Start** button, and then click the **Programs** item.
2. Click your HP product group, and then click the **HP Device Toolbox** item.

<table>
<thead>
<tr>
<th>Tab or section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Home tab</strong></td>
<td>Provides product, status, and configuration information.</td>
</tr>
<tr>
<td><strong>Device Status</strong></td>
<td>Shows the product status and shows the approximate percent life remaining of HP supplies.</td>
</tr>
<tr>
<td><strong>Supplies Status</strong></td>
<td>Shows the approximate percent life remaining of HP supplies. Actual supply life remaining can vary. Consider having a replacement supply available to install when print quality is no longer acceptable. The supply does not need to be replaced unless the print quality is no longer acceptable.</td>
</tr>
<tr>
<td><strong>Device Configuration</strong></td>
<td>Shows the information found on the product configuration page.</td>
</tr>
<tr>
<td><strong>Network Summary</strong></td>
<td>Shows the information found on the product network configuration page.</td>
</tr>
<tr>
<td><strong>Reports</strong></td>
<td>Print the configuration and supplies status pages that the product generates.</td>
</tr>
<tr>
<td><strong>Event Log</strong></td>
<td>Shows a list of all product events and errors.</td>
</tr>
</tbody>
</table>

| **System tab** | Provides the ability to configure the product from your computer. |
| **Device Information** | Provides basic product and company information. |
| **Paper Setup** | Change the default paper-handling settings for the product. |
| **Print Quality** | Change the default print-quality settings for the product. |
| **EcoSMART Console** | Change the default times for entering **Sleep** mode and for **Auto Power Down** mode. Configure which events cause the product to wake. |
| **Paper Types** | Configure print modes that correspond to the paper types that the product accepts. |
| **System Setup** | Change the system defaults for the product. |
| **Service** | Perform the cleaning procedure on the product. |
| **Save and Restore** | Save the current settings for the product to a file on the computer. Use this file to load the same settings onto another product or to restore these settings to this product at a later time. |
| **Administration** | Set or change the product password. Enable or disable product pictures. |

**NOTE:** The **System** tab can be password-protected. If this product is on a network, always consult with the administrator before changing settings on this tab.

<p>| <strong>Print tab</strong> | Provides the ability to change default print settings from your computer. |
| <strong>Printing</strong> | Change the default product print settings, such as number of copies and paper orientation. These are the same options that are available on the control panel. |
| <strong>PCL5c</strong> | View and change the PCL5c settings. |
| <strong>PostScript</strong> | Turn off or on the <strong>Print PS Errors</strong> feature. |</p>
<table>
<thead>
<tr>
<th>Tab or section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax tab</td>
<td>● <strong>Receive Options</strong>: Configure how the product handles incoming faxes.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Phone Book</strong>: Add or delete entries in the fax phone book.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Junk Fax List</strong>: Set fax numbers to block from sending faxes to the product.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Fax Activity Log</strong>: Review recent fax activity for the product.</td>
</tr>
<tr>
<td>Scan tab</td>
<td>Configure the <strong>Scan to Network Folder</strong> and <strong>Scan to E-mail</strong> features.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Network Folder Setup</strong>: Configure folders on the network to which the product can save a scanned file.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Scan to E-mail Setup</strong>: Begin the process to set up the <strong>Scan to E-mail</strong> feature.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Outgoing E-mail Profiles</strong>: Set an email address that will appear as the “from” address for all emails sent from the product. Configure the SMTP Server information.</td>
</tr>
<tr>
<td></td>
<td>● <strong>E-mail Address Book</strong>: Add or delete entries in the email address book.</td>
</tr>
<tr>
<td></td>
<td>● <strong>E-mail Options</strong>: Configure a default subject line and body text. Configure default scan settings for emails.</td>
</tr>
<tr>
<td>Networking tab</td>
<td>Provides the ability to change network settings from your computer.</td>
</tr>
<tr>
<td></td>
<td>Network administrators can use this tab to control network-related settings for the product when it is connected to an IP-based network. It also allows the network administrator to set up Wireless Direct functionality. This tab does not appear if the product is directly connected to a computer.</td>
</tr>
<tr>
<td>HP Web Services tab</td>
<td>Use this tab to set up and use various Web tools with the product.</td>
</tr>
<tr>
<td>HP Smart Install tab</td>
<td>Use this tab to disable HP Smart Install or to download and install the product software.</td>
</tr>
</tbody>
</table>
HP Utility for Mac OS X

Use the HP Utility for Mac OS X to view or change product settings from your computer.

You can use the HP Utility when the product is connected with a USB cable or is connected to a TCP/IP-based network.

Open HP Utility

From the Finder, double-click Applications, double-click HP, and then click HP Utility.

If HP Utility is not included in the Utilities list, use the following procedure to open it:

1. At the computer, open the Apple menu, click the System Preferences menu, and then click the Print & Fax icon or the Print & Scan icon.
2. Select the product in the left side of the window.
3. Click the Options & Supplies button.
4. Click the Utility tab.
5. Click the Open Printer Utility button.

HP Utility features

Use the HP Utility software to perform the following tasks:

- Obtain information about supplies status.
- Obtain information about the product, such as the firmware version and the serial number.
- Print a configuration page.
- Configure the paper type and size for the tray.
- Transfer files and fonts from the computer to the product.
- Upgrade the product firmware.
- Change the Bonjour name for the product on the Bonjour network.
Use HP Web Jetadmin software

HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of networked HP products, including printers, multifunction products, and digital senders. This single solution allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and imaging environment — ultimately increasing business productivity by helping you save time, control costs, and protect your investment.

HP Web Jetadmin upgrades are periodically made available to provide support for specific product features. Go to www.hp.com/go/webjetadmin and click the Self Help and Documentation link to learn more about upgrades.
Economy settings

- **Print with EconoMode**
- **Set the Sleep Delay**
- **Set the Auto Power Down delay**

**Print with EconoMode**

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less toner. However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing the toner cartridge.

**NOTE:** If this option is not available in your print driver, you can set it using the HP Embedded Web Server.

1. From the software program, select the **Print** option.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. Click the **EconoMode** check box.

**Set the Sleep Delay**

1. From the Home screen on the product control panel, touch the **Setup** button.
2. Open the following menus:
   - **System Setup**
   - **Energy Settings**
   - **Sleep Delay**
3. Select the time for the sleep delay.

**NOTE:** The default value is **15 Minutes**.

**Set the Auto Power Down delay**

1. From the Home screen on the product control panel, touch the **Setup** button.
2. Open the following menus:
   - **System Setup**
   - **Energy Settings**
   - **Auto Power Down**
   - **Power Down Delay**
3. Select the time for the power-down delay.
NOTE: The default value is 30 Minutes.

4. The product automatically wakes from the auto power-down mode when it receives jobs or when you touch the screen on the product control panel. You can change which events cause the product to wake. Open the following menus:

- System Setup
- Energy Settings
- Auto Power Down
- Wake Events

To turn off a wake event, select the event and then select the No option.
Product security features

The product supports security standards and recommended protocols that help you keep the product secure, protect critical information on your network, and simplify the way you monitor and maintain the product.

For in-depth information about HP’s secure imaging and printing solutions, visit www.hp.com/go/secureprinting. The site provides links to white papers and FAQ documents about security features.

Lock the product

1. You can attach a security cable to the slot on the back of the product.

Set or change the product password

Use the HP Embedded Web Server to set a password or change an existing password for a product on a network.

1. From the Home screen on the product control panel, touch the Network button to find the product IP address.

2. To open the HP Embedded Web Server, enter the product IP address into the address line of a Web browser.

   NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for Windows or the HP Utility for Mac OS X.

3. Click the System tab, and click the Administration link.

   NOTE: If a password has previously been set, you are prompted to provide the password. Enter the password, and then click the OK button.

4. Enter the new password in the Password box and in the Confirm password box.

5. At the bottom of the window, click the Apply button to save the password.
Upgrade the firmware

HP offers periodic upgrades to the product firmware. You can load the firmware upgrades manually, or you can set the product to automatically load firmware upgrades.

Manually upgrade the firmware

1. From the Home screen on the product control panel, touch the Setup button.

2. Open the following menus:
   - Service
   - LaserJet Update
   - Check For Updates Now

3. Touch the Yes button to prompt the product to search for firmware upgrades. If the product detects an upgrade, it will begin the upgrade process.

Set the product to automatically upgrade the firmware

1. From the Home screen on the product control panel, touch the Setup button.

2. Open the following menus:
   - Service
   - LaserJet Update
   - Manage Updates
   - Prompt Before Install

3. Touch the Install automatically option.
9 Solve problems

- Solve problems checklist
- Restore the factory-set defaults
- Control panel help system
- Paper feeds incorrectly or becomes jammed
- Clear jams
- Improve print quality
- Improve copy quality
- Improve scan quality
- Improve fax quality
- The product does not print or it prints slowly
- Solve walk-up USB printing problems
- Solve fax problems
- Solve USB connection problems
- Solve wired network problems
- Solve wireless network problems
- Solve product software problems with Windows
- Solve product software problems with Mac OS X
- Remove software (Windows)
- Remove software (Mac OS X)
- Solve scan to email problems
- Solve scan to network folder problems
Solve problems checklist

Follow these steps when trying to solve a problem with the product.

- **Step 1: Make sure that the product is set up correctly**
- **Step 2: Check the cabling or wireless connection**
- **Step 3: Check the control panel for error messages**
- **Step 4: Check the paper**
- **Step 5: Check the software**
- **Step 6: Test print functionality**
- **Step 7: Test copy functionality**
- **Step 8: Test the fax functionality**
- **Step 9: Check the toner cartridge**
- **Step 10: Try sending a print job from a computer**
- **Step 11: Verify that the product is on the network**

**Step 1: Make sure that the product is set up correctly**

1. Press the power button to turn on the product or to deactivate the Auto Power Down mode.
2. Check the power-cable connections.
3. Make sure that the line voltage is correct for the product power configuration. (See the label on the back of the product for voltage requirements.) If you are using a power strip and its voltage is not within specifications, connect the product directly to the wall outlet. If it is already connected to a wall outlet, try a different outlet.
4. If none of these measures restores power, contact HP Customer Care.

**Step 2: Check the cabling or wireless connection**

1. Check the cable connection between the product and the computer. Make sure that the connection is secure.
2. Make sure that the cable itself is not faulty by using a different cable, if possible.
3. If the product is connected to a network, check the following items:
   - Check the light next to the network connection on the product. If the network is active, the light is green.
   - Make sure that you are using a network cable and not a phone cord to connect to the network.
   - Make sure the network router, hub, or switch is turned on and that it is working correctly.
• If your computer or the product is connected to a wireless network, low signal quality or interference might be delaying print jobs.

• If the product is connected wirelessly, print a Wireless Network Test Report to verify that the wireless connection is working correctly.
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Touch the Self Diagnostics button.
  c. Touch the Run Wireless Test button to print the report.

4. If you are using a personal firewall system on the computer, it might be blocking communication with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

Step 3: Check the control panel for error messages

The control panel should indicate ready status. If an error message displays, resolve the error.

Step 4: Check the paper

1. Make sure that the paper that you are using meets specifications.

2. Make sure that the paper is loaded correctly in the input tray.

Step 5: Check the software

1. Make sure that the product software is installed correctly.

2. Verify that you have installed the print driver for this product. Check the program to make sure that you are using the print driver for this product.

Step 6: Test print functionality

1. Print a configuration report.
   a. From the Home screen on the product control panel, touch the Information button.
   b. Touch the Report button to print the configuration report.

2. If the page does not print, verify that the input tray contains paper.

3. If the page jams in the product, clear the jam.

Step 7: Test copy functionality

1. Place the configuration page into the document feeder and make a copy. If paper does not feed smoothly through the document feeder, you might need to clean the document feeder rollers and separation pad. Make sure the paper meets specifications for this product.

2. Place the configuration page onto the scanner glass and make a copy.

3. If the print quality on the copied pages is not acceptable, clean the scanner glass and the small glass strip.
Step 8: Test the fax functionality

1. From the Home screen on the product control panel, touch the Setup button.

2. Open the following menus:
   - Service
   - Fax Service

3. Touch the Run Fax Test button to print the Fax Test Report, which provides information about fax functionality.

Step 9: Check the toner cartridge

Print a supplies status page and check remaining life of the toner cartridge.

1. From the Home screen on the product control panel, touch the Supplies button.

2. Touch the Report button to print the supplies status page.

Step 10: Try sending a print job from a computer

1. Try printing the job from another computer that has the product software installed.

2. Check the USB or network cable connection. Direct the product to the correct port, or reinstall the software, selecting the connection type that you are using.

3. If the print quality is unacceptable, verify that the print settings are correct for the paper that you are using.

Step 11: Verify that the product is on the network

For networked products, open a Web browser, and enter the product IP address (from the previously printed configuration page) in the address box to open the HP Embedded Web Server (EWS). If the HP EWS does not open, reinstall the product on the network.
Restore the factory-set defaults

Restoring the factory-set defaults returns all of the product and network settings to the factory defaults. It will not reset the page count, tray size, or language. To restore the product to the factory-default settings, follow these steps.

⚠️ **CAUTION:** Restoring the factory-set defaults returns all of the settings to the factory defaults, and it also deletes any pages that are stored in the memory.

1. On the product control panel, touch the Setup button.
2. Scroll to and touch the Service menu.
3. Scroll to and touch the Restore Defaults button, and then touch the OK button.

   The product automatically restarts.
Control panel help system

The product has a built-in Help system that explains how to use each screen. To open the Help system, touch the Help ? button in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can browse through the menu structure by touching the buttons in the menu.

Some Help screens include animations that guide you through procedures, such as clearing jams.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options for that screen.

If the product alerts you of an error or warning, touch the Help ? button to open a message that describes the problem. The message also contains instructions to help solve the problem.
Paper feeds incorrectly or becomes jammed

- The product does not pick up paper
- The product picks up multiple sheets of paper
- The document feeder jams, skews, or picks up multiple sheets of paper
- Prevent paper jams from the paper trays

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.
2. Load the tray with the correct size of paper for your job.
3. Make sure the paper size and type are set correctly on the product control panel.
4. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to the appropriate indentation in the tray.
5. Check the product control panel to see if the product is waiting for you to acknowledge a prompt to feed the paper manually. Load paper, and continue.
6. The rollers above the tray might be contaminated. Clean the rollers with a lint-free cloth dampened with warm water.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the paper. Return the stack of paper to the tray.
2. Use only paper that meets HP specifications for this product.
3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.
4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the stack, and then return some of the paper to the tray.
5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to the appropriate indentation in the tray.
6. Make sure the printing environment is within recommended specifications.

The document feeder jams, skews, or picks up multiple sheets of paper

- The original might have something on it, such as staples or self-adhesive notes, that must be removed.
- Make sure that the document-feeder cover is closed.
- The pages might not be placed correctly. Straighten the pages and adjust the paper guides to center the stack.
- The paper guides must be touching the sides of the paper stack to work correctly. Make sure that the paper stack is straight and the guides are against the paper stack.
● Verify that there are no pieces of paper, staples, paper clips, or other debris in the paper path.
● Clean the document-feeder rollers and the separation pad. Use compressed air or a clean, lint-free cloth moistened with warm water.

**Prevent paper jams from the paper trays**

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.
2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.
3. Use paper that has not previously been printed or copied on.
4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the stack, and then return some of the paper to the tray.
5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so they are touching the paper stack without bending it.
6. Make sure that the tray is fully inserted in the product.
7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and feed sheets one at a time.
8. Verify that the tray is configured correctly for the paper type and size.
9. Make sure the printing environment is within recommended specifications.
Clear jams

- Jam locations
- Clear jams in the document feeder
- Clear jams in the output area
- Clear jams in Tray 1
- Clear jams in Tray 2 or optional Tray 3
- Clear jams in the fuser
- Clear jams in the duplexer

Jam locations

Use this illustration to identify locations of jams. In addition, instructions display on the control panel to direct you to the location of jammed paper and how to clear it.

**NOTE:** Internal areas of the product that might need to be opened to clear jams have green handles or green labels.

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Document-feeder area</td>
</tr>
<tr>
<td>2</td>
<td>Output-bin area</td>
</tr>
<tr>
<td>3</td>
<td>Top-cover and toner-cartridge area</td>
</tr>
<tr>
<td>4</td>
<td>Tray 1 area</td>
</tr>
<tr>
<td>5</td>
<td>Tray 2 pickup area</td>
</tr>
<tr>
<td></td>
<td>Duplexing area (remove Tray 2 for access)</td>
</tr>
<tr>
<td>6</td>
<td>Optional Tray 3</td>
</tr>
<tr>
<td>7</td>
<td>Rear door</td>
</tr>
</tbody>
</table>
Clear jams in the document feeder

1. Open the document-feeder cover.

2. Gently pull the jammed paper out.
3. Close the document-feeder cover. Make sure it is completely closed.

4. Open the scanner lid. If paper is jammed in the scanner lid, gently pull it out.
Clear jams in the output area

1. If paper is visible from the output bin, grasp the leading edge and remove it.

2. Open the rear door, and push down so it is fully opened to a 90° angle.

   **NOTE:** The rear door has two positions. It opens to a 45° angle for the rear output bin and to a 90° angle for clearing jams.
3. Remove any jammed paper.

4. Close the rear door.
Clear jams in Tray 1

1. If most of the sheet of paper is visible in the tray, slowly pull the jammed paper out of the product. If most of the sheet of paper has been pulled inside the product, continue with the following steps.

2. Press the front-door-release button.

3. Open the front door.
4. Remove the toner cartridge.

5. Lift the jam-access covers and remove any jammed paper.
6. Reinsert the toner cartridge.

7. Close the front door.
Clear jams in Tray 2 or optional Tray 3

1. Remove the tray from the product.

2. Remove the paper from the tray, and discard any damaged paper.

3. Verify that the rear paper guide is adjusted to the indentation for the correct paper size. If necessary, pinch the release and move the rear paper guide to the correct position. It should click into place.
4. Load the paper into the tray. Make sure that the stack is flat at all four corners and that the top of the stack is below the maximum-height indicators.

5. Reinsert and close the tray.

6. Press the front-door-release button.
7. Open the front door.

8. Remove the toner cartridge.

9. Lift the jam-access covers and remove any jammed paper.
10. Reinsert the toner cartridge.

11. Close the front door.
Clear jams in the fuser

1. Press the front-door-release button.

2. Open the front door.

3. Remove the toner cartridge.
4. Lift the jam-access covers and remove any jammed paper.

5. Reinsert the toner cartridge.

6. Close the front door.
Clear jams in the duplexer

1. Completely remove Tray 2 from the product.

2. Push the green button to release the duplex pan.

3. Remove any jammed paper.
4. Close the duplex pan.

5. Reinsert Tray 2.
**Improve print quality**

- **Print from a different software program**
- **Set the paper-type setting for the print job**
- **Check the toner-cartridge status**
- **Print a cleaning page**
- **Visually inspect the toner cartridge**
- **Check the paper and printing environment**
- **Check the EconoMode settings**
- **Try a different print driver**

**Print from a different software program**

Try printing from a different software program. If the page prints correctly, the problem is with the software program from which you were printing.

**Set the paper-type setting for the print job**

Check the paper type-setting if you are printing from a software program and the pages have any of these problems:

- smeared print
- fuzzy print
- dark print
- curled paper
- scattered dots of toner
- loose toner
- small areas of missing toner

**Check the paper-type setting (Windows)**

1. From the software program, select the **Print** option.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. From the **Paper type** drop-down list, click the **More...** option.
5. Expand the list of **Type is:** options.
6. Expand the category of paper types that best describes your paper.
7. Select the option for the type of paper you are using, and click the OK button.

8. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK button to print the job.

Check the paper-type setting (Mac OS X)

1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.
3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then click the Finishing menu.
4. Select a type from the Media-type drop-down list.
5. Click the Print button.

Check the toner-cartridge status

Check the supplies status page for the following information:

- Estimated percentage of cartridge life remaining
- Approximate pages remaining
- Part numbers for HP toner cartridges
- Number of pages printed

Use the following procedure to print the supplies status page:

1. From the Home screen on the product control panel, touch the Supplies button.
2. Touch the Report button to print the supplies status page.

Print a cleaning page

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Service menu.
3. Touch the Cleaning Page button.
4. Load plain letter or A4 paper when you are prompted.
5. Touch the OK button to begin the cleaning process.

   The product prints the first side and then prompts you to remove the page from the output bin and reload it in Tray 1, keeping the same orientation. Wait until the process is complete. Discard the page that prints.

Visually inspect the toner cartridge

1. Remove the toner cartridge from the product, and verify that the sealing tape has been removed.
2. Check the memory chip for damage.
3. Examine the surface of the green imaging drum on the toner cartridge.
CAUTION: Do not touch the imaging drum. Fingerprints on the imaging drum can cause print-quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the toner cartridge.

5. If the imaging drum does not appear to be damaged, rock the toner cartridge gently several times and reinstall it. Print a few pages to see if the problem has resolved.

Check the paper and printing environment

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

- The printing is too light or seems faded in areas.
- Specks of toner are on the printed pages.
- Toner is smearing on the printed pages.
- Printed characters seem misformed.
- Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines when selecting paper:

- Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, voids, staples, and curled or bent edges.
- Use paper that has not been previously printed on.
- Use paper that is designed for use in laser printers. Do not use paper that is designed only for use in inkjet printers.
- Use paper that is not too rough. Using smoother paper generally results in better print quality.

Check the product environment

Verify that the product is operating within the environmental specifications listed in the product Warranty and Legal Guide.

Check the EconoMode settings

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing the toner cartridge.

NOTE: This feature is available with the PCL 6 print driver for Windows. If you are not using that driver, you can enable the feature by using the HP Embedded Web Server.

Follow these steps if the entire page is too dark or too light.

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.
3. Click the **Paper/Quality** tab, and locate the **Print Quality** area.

4. If the entire page is too dark, use these settings:
   - Select the **600 dpi** option.
   - Select the **EconoMode** check box to enable it.
   If the entire page is too light, use these settings:
   - Select the **FastRes 1200** option.
   - Clear the **EconoMode** check box to disable it.

5. Click the **OK** button to close the **Document Properties** dialog box. In the **Print** dialog, click the **OK** button to print the job.

**Try a different print driver**

You might need to use a different print driver if the printed page has unexpected lines in graphics, missing text, missing graphics, incorrect formatting, or substituted fonts.

<table>
<thead>
<tr>
<th><strong>HP PCL 6 driver</strong></th>
<th>Provided as the default driver. This driver is automatically installed unless you select a different one.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Recommended for all Windows environments</td>
</tr>
<tr>
<td></td>
<td>Provides the overall best speed, print quality, and product-feature support for most users</td>
</tr>
<tr>
<td></td>
<td>Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in Windows environments</td>
</tr>
<tr>
<td></td>
<td>Might not be fully compatible with third-party and custom software programs that are based on PCL 5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>HP UPD PS driver</strong></th>
<th>Recommended for printing with Adobe® software programs or with other highly graphics-intensive software programs</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Provides support for printing from postscript emulation needs, or for postscript flash font support</td>
</tr>
<tr>
<td>HP UPD PCL 5</td>
<td>Recommended for general office printing in Windows environments</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Compatible with previous PCL versions and older HP LaserJet products</td>
</tr>
<tr>
<td></td>
<td>The best choice for printing from third-party or custom software programs</td>
</tr>
<tr>
<td></td>
<td>The best choice when operating with mixed environments, which require the product to be set to PCL 5 (UNIX, Linux, mainframe)</td>
</tr>
<tr>
<td></td>
<td>Designed for use in corporate Windows environments to provide a single driver for use with multiple product models</td>
</tr>
<tr>
<td></td>
<td>Preferred when printing to multiple product models from a mobile Windows computer</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HP UPD PCL 6</th>
<th>Recommended for printing in all Windows environments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Provides the overall best speed, print quality, and product feature support for most users</td>
</tr>
<tr>
<td></td>
<td>Developed to align with Windows Graphic Device Interface (GDI) for best speed in Windows environments</td>
</tr>
<tr>
<td></td>
<td>Might not be fully compatible with third-party and custom solutions based on PCL5</td>
</tr>
</tbody>
</table>

**Improve copy quality**

- Check the scanner glass for dirt and smudges
- Check the paper settings
- Optimize for text or pictures
- Edge-to-edge copying
- Clean the pickup rollers and separation pad in the document feeder

**Check the scanner glass for dirt and smudges**

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can affect performance. Use the following procedure to clean the scanner.

1. Press the power button to turn the product off, and then disconnect the power cable from the electrical outlet.

2. Open the scanner lid.

3. Clean the scanner glass, the document feeder strips, and the white plastic backing with a soft cloth or sponge that has been moistened with nonabrasive glass cleaner.

**CAUTION:** Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon tetrachloride on any part of the product; these can damage the product. Do not place liquids directly on the glass or platen. They might seep and damage the product.
4. Dry the glass and white plastic parts with a chamois or a cellulose sponge to prevent spotting.

5. Connect the power cable to an outlet, and then press the power button to turn the product on.

Check the paper settings

1. From the Home screen on the product control panel, touch the Copy button.
2. Touch the Settings button, and then scroll to and touch the Paper button.
3. From the list of paper sizes, touch the name of the paper size that is in Tray 1.
4. From the list of paper types, touch the name of the paper type that is in Tray 1.
5. Touch the Start Copy button to start copying.

Optimize for text or pictures

The following copy-quality settings are available:

- **Auto Select**: Use this setting when you are not concerned about the quality of the copy. This is the default setting.
- **Mixed**: Use this setting for documents that contain a mixture of text and graphics.
- **Text**: Use this setting for documents that contain mostly text.
- **Picture**: Use this setting for documents that contain mostly graphics.
1. Load the document onto the scanner glass or into the document feeder.

2. From the Home screen on the product control panel, touch the Copy button.

3. Touch the Settings button, and then scroll to and touch the Optimize button. Touch the arrow buttons to scroll through the options, and then touch an option to select it.

4. Touch the Start Copy button to start copying.

**Edge-to-edge copying**

The product cannot print fully edge-to-edge. There is a 4 mm unprintable border around the page.

**Considerations for printing or scanning documents with cropped edges:**

- When the original is smaller than the output size, move the original 4 mm (1/6 inch) away from the corner indicated by the icon on the scanner. Recopy or scan in this position.
- When the original is the size of the printed output that you want, use the Reduce/Enlarge feature to reduce the image so the copy is not cropped.

**Clean the pickup rollers and separation pad in the document feeder**

If the product document feeder experiences paper-handling problems, such as jams or multiple-page feeds, clean the document-feeder rollers and separation pad.

1. Open the document-feeder cover.
2. Use a moist, lint-free cloth to wipe both pickup rollers and the separation pad to remove dirt.

**CAUTION:** Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon tetrachloride on any part of the product; these can damage the product. Do not place liquids directly on the glass or platen. They might seep and damage the product.

3. Close the document-feeder cover.
Improve scan quality

- Check the scanner glass for dirt and smudges
- Clean the pickup rollers and separation pad in the document feeder

Check the scanner glass for dirt and smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can affect performance. Use the following procedure to clean the scanner.

1. Press the power button to turn the product off, and then disconnect the power cable from the electrical outlet.

2. Open the scanner lid.

3. Clean the scanner glass, the document feeder strips, and the white plastic backing with a soft cloth or sponge that has been moistened with nonabrasive glass cleaner.

   **CAUTION:** Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon tetrachloride on any part of the product; these can damage the product. Do not place liquids directly on the glass or platen. They might seep and damage the product.
4. Dry the glass and white plastic parts with a chamois or a cellulose sponge to prevent spotting.

5. Connect the power cable to an outlet, and then press the power button to turn the product on.

---

**Clean the pickup rollers and separation pad in the document feeder**

If the product document feeder experiences paper-handling problems, such as jams or multiple-page feeds, clean the document-feeder rollers and separation pad.

1. Open the document-feeder cover.
2. Use a moist, lint-free cloth to wipe both pickup rollers and the separation pad to remove dirt.

**CAUTION:** Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon tetrachloride on any part of the product; these can damage the product. Do not place liquids directly on the glass or platen. They might seep and damage the product.

3. Close the document-feeder cover.
Improve fax quality

- Check the scanner glass for dirt and smudges
- Check the send-fax resolution setting
- Check the error correction setting
- Send to a different fax machine
- Clean the pickup rollers and separation pad in the document feeder
- Check the fit-to-page setting
- Check the sender's fax machine

Check the scanner glass for dirt and smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can affect performance. Use the following procedure to clean the scanner.

1. Press the power button to turn the product off, and then disconnect the power cable from the electrical outlet.

2. Open the scanner lid.

3. Clean the scanner glass, the document feeder strips, and the white plastic backing with a soft cloth or sponge that has been moistened with nonabrasive glass cleaner.

   **CAUTION:** Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon tetrachloride on any part of the product; these can damage the product. Do not place liquids directly on the glass or platen. They might seep and damage the product.
4. Dry the glass and white plastic parts with a chamois or a cellulose sponge to prevent spotting.

5. Connect the power cable to an outlet, and then press the power button to turn the product on.

Check the send-fax resolution setting

If the product was unable to send a fax because the receiving fax machine did not answer or was busy, the product attempts to redial based on the redial-on-busy, redial-on-no-answer, and redial-on-communication-error options.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Open the Fax Resolution menu.

Check the error correction setting

Usually, the product monitors the signals on the telephone line while it is sending or receiving a fax. If the product detects an error during the transmission and the error-correction setting is On, the product can request that the portion of the fax be resent. The factory-set default for error correction is On.

You should turn off error correction only if you are having trouble sending or receiving a fax, and you are willing to accept the errors in the transmission. Turning off the setting might be useful when you are trying to send a fax overseas or receive one from overseas, or if you are using a satellite telephone connection.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Service menu.
3. Touch the Fax Service menu.
4. Touch the Error Correction button, and then touch the On button.

Send to a different fax machine

Send the fax job to a different fax machine to see if another machine will successfully receive the fax job.
Clean the pickup rollers and separation pad in the document feeder

If the product document feeder experiences paper-handling problems, such as jams or multiple-page feeds, clean the document-feeder rollers and separation pad.

1. Open the document-feeder cover.

2. Use a moist, lint-free cloth to wipe both pickup rollers and the separation pad to remove dirt.

   **CAUTION:** Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon tetrachloride on any part of the product; these can damage the product. Do not place liquids directly on the glass or platen. They might seep and damage the product.

3. Close the document-feeder cover.

Check the fit-to-page setting

If the product printed a fax job off the page, turn on the fit-to-page feature from the product control panel.

**NOTE:** Make sure that the default paper size setting matches the size of the paper in the tray.
1. From the Home screen on the product control panel, touch the Setup button.

2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Touch the Fit to Page button, and then touch the On button.

**Check the sender's fax machine**

Ask the sender to darken the contrast setting on the sending fax machine, and then resend the fax.
The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.
   - If the control panel does not indicate the product is ready, turn the product off and then on again.
   - If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check the following items:
   - Check the light next to the network connection on the product. If the network is active, the light is green.
   - Make sure that you are using a network cable and not a phone cord to connect to the network.
   - Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic print drivers can cause delays clearing jobs from the print queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties, and open the Ports tab.
   - If you are using a network cable to connect to the network, make sure the printer name listed on the Ports tab matches the product name on the product configuration page.
   - If you are using a USB cable and are connecting to a wireless network, make sure the box is checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or interference might be delaying print jobs.

The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of specifications, go to this Web site: www.hp.com/support/ljmfpM521series.

2. When you configure the product to print on some paper types, such as heavy paper, the product prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not correct for the type of paper you are using, change the setting to the correct paper type.

3. If your computer or the product is connected to a wireless network, low signal quality or interference might be delaying print jobs.
Solve walk-up USB printing problems

- **The USB Flash Drive menu does not open when you insert the USB flash drive**
- **The file does not print from the USB flash drive**
- **The file that you want to print is not listed in the USB Flash Drive menu**

### The USB Flash Drive menu does not open when you insert the USB flash drive

1. You might be using a USB flash drive or a file system that this product does not support. Save the files on a standard USB flash drive that uses File Allocation Table (FAT) file systems. The product supports FAT12, FAT16, and FAT32 USB storage accessories.

2. If another menu is already open, close that menu and then reinsert the USB flash drive.

3. The USB flash drive might have multiple partitions. (Some USB flash drive manufacturers install software on the drive that creates partitions, similar to a CD.) Reformat the USB flash drive to remove the partitions, or use a different USB flash drive.

4. The USB flash drive might require more power than the product can provide.
   a. Remove the USB flash drive.
   b. Turn the product off and then on.
   c. Use a USB flash drive that has its own power supply or that requires less power.

5. The USB flash drive might not be functioning correctly.
   a. Remove the USB flash drive.
   b. Turn the product off and then on.
   c. Try printing from another USB flash drive.

### The file does not print from the USB flash drive

1. Make sure paper is in the tray.

2. Check the control panel for messages. If paper is jammed in the product, clear the jam.

### The file that you want to print is not listed in the USB Flash Drive menu

1. You might be trying to print a file type that the USB printing feature does not support. The product supports .PDF and JPEG file types.

2. You might have too many files in a single folder on the USB flash drive. Reduce the number of files in the folder by moving them to subfolders.

3. You might be using a character set for the file name that the product does not support. In this case, the product replaces the file names with characters from a different character set. Rename the files using ASCII characters.
Solve fax problems

- Checklist for solving fax problems
- Perform a fax diagnostic test
- Fax trace report
- Fax error report printing
- Set the fax-error-correction mode
- Change the fax speed
- Solve problems sending faxes
- Solve problems receiving faxes
- Solve general fax problems

Checklist for solving fax problems

- Several possible fixes are available. After each recommended action, retry faxing to see if the problem is resolved.
- For best results during fax problem solving, make sure the line from the product is connected directly to the wall phone port. Disconnect all other devices that are connected to the product.

1. Verify that the telephone cord is connected to the correct port on the back of the product.
2. Check the phone line by using the fax test:
   a. From the Home screen on the product control panel, touch the Setup button, and then touch the Service menu.
   b. Select the Fax Service menu.
   c. Select the Run Fax Test option. The product prints a fax test report.
      The report contains the following possible results:
      - Pass: The report contains all of the current fax settings for review.
      - Fail: The report indicates the nature of the error and contains suggestions for how to resolve the issue.
3. Verify that the product firmware is current:
   a. Print a configuration page from the control panel Reports menu to obtain the current firmware date code.
      1. Click the Support & Drivers link.
      2. Click the Download drivers and software (and firmware) link option.
      3. In the For product box, enter the product model number, and then click the Go button.
4. Click the link for your operating system.

5. Scroll to the Firmware section of the table.
   - If the listed version matches the version on the configuration page, you have the most current version.
   - If the versions are different, download the firmware upgrade file and upgrade the firmware on the product following the on-screen instructions.

   \[ \textbf{NOTE:} \quad \text{The product must be connected to a computer with internet access to upgrade firmware.} \]

   - Resend the fax.

4. Verify that the fax was set up when the product software was installed.
   From the computer, in the HP program folder, run the Fax Setup Utility.

5. Verify that the telephone service supports analog fax.
   - If using ISDN or digital PBX, contact your service provider for information about configuring to an analog fax line.
   - If using a VoIP service, change the Fax Speed setting to Slow(V.29) from the control panel. Ask if your service provider supports fax and for the recommended fax modem speed. Some companies might require an adapter.
   - If you are using a DSL service, make sure that a filter is included on the phone-line connection to the product. Contact the DSL service provider, or purchase a DSL filter if you do not have one. If a DSL filter is installed, try another filter because filters can be defective.

6. If the error persists, find more detailed problem-solving solutions in the sections that follow this one.

**Perform a fax diagnostic test**

From the product control panel, you can run a diagnostic test that provides information about the product fax settings.

1. From the Home screen on the product control panel, touch the Setup button.

2. Open the following menus:
   - Service
   - Fax Service

3. Touch the Run Fax Test button to start the test. The product prints a test page that shows test results.
Fax trace report

A fax T.30 trace report has information that can help resolve fax transmission problems. If you call HP for help in resolving these problems, print a T.30 trace report before you call.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Service menu.
3. Touch the Fax Service menu.
4. Touch the Print T.30 Trace button, and then touch the Now button.

**NOTE:** This procedure prints a report for the last fax job, successful or not. To generate a report for each unsuccessful fax job, select the If Error setting. To generate a report for each fax job, select the At End of Call setting.

Fax error report printing

Use the following instructions to print fax logs and reports:

Print all fax reports

Use this procedure to print all of the following reports at one time:

- Last Call Report
- Fax Activity Log
- Phone Book Report
- Junk Fax List
- Billing Report (when Billing Codes are turned on)
- Configuration Report
- Usage Page

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Fax Reports button.
4. Touch the Print All fax Reports button.

Print individual fax reports

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Fax Reports button.
4. Touch the name of the report that you want to print.
**Set the fax error report**

A fax error report is a brief report that indicates the product experienced a fax job error. You can set it to print after the following events:

- Every fax error (the factory-set default)
- Send fax error
- Receive fax error
- Never

**NOTE:** With this option, you will have no indication that a fax failed to be transmitted unless you print a fax activity log.

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Fax Reports button.
4. Touch the Fax Error Report button, and then touch the printing option that you want to use.

**Set the fax-error-correction mode**

Usually, the product monitors the signals on the telephone line while it is sending or receiving a fax. If the product detects an error during the transmission and the error-correction setting is On, the product can request that the portion of the fax be resent. The factory-set default for error correction is On.

You should turn off error correction only if you are having trouble sending or receiving a fax, and you are willing to accept the errors in the transmission. Turning off the setting might be useful when you are trying to send a fax overseas or receive one from overseas, or if you are using a satellite telephone connection.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Service menu.
3. Touch the Fax Service menu.
4. Touch the Error Correction button, and then touch the On button.

**Change the fax speed**

The fax-speed setting is the modem protocol that the product uses to send faxes. It is the worldwide standard for full-duplex modems that send and receive data across telephone lines at up to 33,600 bits per second (bps). The factory-set default for the fax-speed setting is Fast(V.34).

You should change the setting only if you are having trouble sending a fax to or receiving a fax from a particular device. Decreasing the fax speed might be useful when you are trying to send a fax overseas, or receive one from overseas, or if you are using a satellite telephone connection.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Scroll to and touch the Fax Speed button, and then touch the speed setting that you want to use.
Solve problems sending faxes

- An error message displays on the control panel
- The control panel displays a Ready message with no attempt to send the fax
- The control panel displays the message “Storing page 1” and does not progress beyond that message
- Faxes can be received, but not sent
- Product is password protected
- Unable to use fax functions from the control panel
- Unable to use speed dials
- Unable to use group dials
- Receive a recorded error message from the phone company when trying to send a fax
- Unable to send a fax when a phone is connected to the product

An error message displays on the control panel

The Communication error message appears

- Allow the product to retry sending the fax. Re-sending temporarily reduces the fax speed.
- Disconnect the product telephone cord from the wall, connect a telephone to the phone jack on the wall, and try making a call. Connect the product phone cord to a jack for another phone line.
- Try a different phone cord.
- From the control panel, change the Fax Speed option to the Medium(V.17) setting or Slow(V.29) setting.
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Fax Setup menu.
  c. Open the Advanced Setup menu.
  d. Open the Fax Speed menu.
  e. Select the correct setting.
- Turn off the Error Correction option.
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Service menu.
  c. Open the Fax Service menu.
  d. Open the Error Correction menu.
  e. Select the Off setting.
NOTE: Turning off the Error Correction option can reduce image quality.

- If the error persists, contact HP. See www.hp.com/support/ljmfpM521series or the support flyer that came in the product box.

No dial tone

- Make sure that the telephone cord is connected to the correct port on the product.
- Make sure that the telephone cord from the product is connected directly to the wall telephone jack.
- Check for a dial tone on the phone line by using the Start Fax button.
- Disconnect the product telephone cord from the wall, connect a telephone to the phone jack on the wall, and try making a voice call.
- Disconnect the telephone cord from both the product and the wall and reconnect the cord.
- Make sure that you are using the telephone cord that came with the product.
- Connect the product phone cord to a jack for another phone line.
- Check the phone line by using the Run Fax Test option from the Service menu on the control panel.
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Service menu.
  c. Open the Fax Service menu.
  d. Select the Run Fax Test item.

The Fax is busy message appears

- Try sending the fax again.
- Call the recipient to ensure that the fax machine is on and ready.
- Check that you are dialing the correct fax number.
- Check for a dial tone on the phone line by using the Start Fax button.
- Make sure that the phone line is working by disconnecting the product, connecting a telephone to the phone line, and making a voice call.
- Connect the product phone cord to a jack for another phone line, and try sending the fax again.
- Try a different phone cord.
- Send the fax at a later time.
- If the error persists, contact HP. See www.hp.com/support/ljmfpM521series or the support flyer that came in the product box.

The No fax answer message appears

- Try to resend the fax.
- Call the recipient to ensure that the fax machine is on and ready.
- Check that you are dialing the correct fax number.
- Disconnect the product telephone cord from the wall, connect a telephone to the phone jack on the wall, and try making a voice call.
- Connect the product phone cord to a jack for another phone line.
- Try a different phone cord.
- Make sure that the phone cord from the wall telephone jack is connected to the line port.
- Check the phone line by using the Run Fax Test option from the Service menu on the control panel.
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Service menu.
  c. Open the Fax Service menu.
  d. Select the Run Fax Test item.
- If the error persists, contact HP. See www.hp.com/support/ljmfpM521series or the support flyer that came in the product box.

Document feeder paper jam
- Verify that the paper meets product size requirements. The product does not support pages longer than 381 mm (15 in) for faxing.
- Copy or print the original to letter, A4, or legal size paper, and then resend the fax.

The Fax storage is full message appears
- Turn the product off then on.
- Print stored faxes that have not been printed.
  a. Touch the Fax button, and then touch the Fax Menu button.
  b. Open the Receive Options menu.
  c. Select the Print Private Faxes item.
  d. Provide the password when the product prompts you.
- Delete stored faxes from memory.
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Service menu.
  c. Open the Fax Service menu.
  d. Select the Clear Saved Faxes item.
- Divide the large fax job into smaller sections, and then fax them individually.
Scanner error

- Verify that the paper meets product size requirements. The product does not support pages longer than 381 mm (15 in) for faxing.
- Copy or print the original onto letter, A4, or legal size paper and then resend the fax.

The control panel displays a Ready message with no attempt to send the fax

- Check the fax activity log for errors.
  a. Touch the Fax button, and then touch the Fax Menu button.
  b. Open the Fax Reports menu.
  c. Open the Fax Activity Log menu.
  d. Select the Print Log Now option.
- If a phone is connected to the product, make sure that the phone is hung up.
- Disconnect all other lines between the fax and the product.
- Connect the product directly into the wall telephone jack and resend the fax.

The control panel displays the message "Storing page 1" and does not progress beyond that message

- Delete stored faxes from memory.
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Service menu.
  c. Open the Fax Service menu.
  d. Select the Clear Saved Faxes item.

Faxes can be received, but not sent

Send fax and nothing happens.

1. Check for a dial tone on the phone line by using the Start Fax button.
2. Turn the product off then on.
3. Use the control panel or the HP Fax Setup Wizard to configure the fax time, date, and fax header information.
   a. From the Home screen on the product control panel, touch the Setup button.
   b. Open the Fax Setup menu.
   c. Open the Basic Setup menu.
   d. Open the Fax Header menu.
   e. Enter the correct settings.
4. Verify that any extension phones on the line are hung up.

5. If using a DSL service, make sure that the phone line connection to the product includes a high-pass filter.

**Product is password protected**

If a network administrator has set a product password, then you must obtain the password in order to use the product fax features.

**Unable to use fax functions from the control panel**

- The product might be password protected. Use the HP Embedded Web Server, HP Toolbox software, or the control panel to set a password.
- If you do not know the password for the product, contact your system administrator.
- Verify with the system administrator that the fax functionality has not been disabled.

**Unable to use speed dials**

- Make sure that the fax number is valid.
- If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed dial number.
  
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Fax Setup menu.
  c. Open the Basic Setup menu.
  d. Open the Dial Prefix menu.
  e. Select the On setting.

**Unable to use group dials**

- Make sure that the fax number is valid.
- If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed dial number.
  
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Fax Setup menu.
  c. Open the Basic Setup menu.
  d. Open the Dial Prefix menu.
  e. Select the On setting.
- Set up all entries in the group with speed dial entries.
a. Open an unused speed dial entry.
b. Enter the fax number for the speed dial.
c. Touch the OK button to save the speed dial.

Receive a recorded error message from the phone company when trying to send a fax

- Make sure you dial the fax number correctly, and make sure that the phone service is not blocked. For example, some phone services might prevent long distance calling.
- If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed dial number.

a. From the Home screen on the product control panel, touch the Setup button.
b. Open the Fax Setup menu.
c. Open the Basic Setup menu.
d. Open the Dial Prefix menu.
e. Select the On setting.

**NOTE:** To send a fax without a prefix, when the Dial Prefix option is turned on, send the fax manually.

- Send a fax to an international number
  a. If a prefix is required, manually dial the telephone number with the prefix.
  b. Enter the country/region code before dialing the phone number.
  c. Wait for pauses as you hear the tones on the phone.
  d. Send the fax manually from the control panel.

Unable to send a fax when a phone is connected to the product

- Make sure that the telephone is hung up.
- Make sure that the telephone is not being used for a voice call when faxing.
- Disconnect the phone from the line, and then try sending the fax.

Solve problems receiving faxes

- The fax does not respond
- An error message displays on the control panel
- A fax is received but does not print
- Sender receives a busy signal
- No dial tone
- Cannot send or receive a fax on a PBX line
The fax does not respond

The fax has a dedicated phone line

- Set the Answer Mode option to the Automatic setting from the control panel.
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Fax Setup menu.
  c. Open the Basic Setup menu.
  d. Open the Answer Mode menu.
  e. Select the Automatic setting.

An answering machine is connected to the product

- Set the Answer Mode option to the TAM setting and connect the answering machine to the “telephone” port.
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Fax Setup menu.
  c. Open the Basic Setup menu.
  d. Open the Answer Mode menu.
  e. Select the TAM setting.

If the TAM setting is unavailable, set the Answer Mode option to the Automatic setting.

- Set the Rings to Answer setting to at least one ring more than the number of rings for which the answering machine is set.
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Fax Setup menu.
  c. Open the Basic Setup menu.
  d. Open the Rings to Answer menu.
  e. Select the correct setting.

- Connect the answering machine to the “telephone” port.

- If the product has a telephone handset connected, set the Answer Mode option to the Fax/Tel setting to route calls to the correct device. When detecting a voice call, the product generates a ring tone that alerts you to pick up the telephone handset.
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Fax Setup menu.
  c. Open the Basic Setup menu.
d. Open the Answer Mode menu.

e. Select the Fax/Tel setting.

The Answer Mode setting is set to the Manual setting
   ● Touch the Start Fax button on the product control panel.

Voice mail is available on the fax line
   ● Add a distinctive ring service to your telephone line and change the Distinctive Ring setting on the product to match the ring pattern supplied by the telephone company. Contact your telephone company for information.
      a. From the Home screen on the product control panel, touch the Setup button.
      b. Open the Fax Setup menu.
      c. Open the Basic Setup menu.
      d. Open the Distinctive Ring menu.
      e. Select the correct setting.
   ● Buy a dedicated line for faxing.
   ● Set the Answer Mode option to the Manual setting.
      a. From the Home screen on the product control panel, touch the Setup button.
      b. Open the Fax Setup menu.
      c. Open the Basic Setup menu.
      d. Open the Answer Mode menu.
      e. Select the Manual setting.

NOTE: You must be present to receive faxes.

The product is connected to a DSL phone service
   ● Check the installation and features. A DSL modem requires a high-pass filter on the phone line connection to the product. Contact your DSL service provider for a filter or buy a filter.
   ● Verify that the filter is connected.
   ● Replace the existing filter to make sure that it is not defective.

The product uses a fax over IP or VoIP phone service
   ● Set the Fax Speed option to the Slow(V.29) or Medium(V.17) setting.
      a. From the Home screen on the product control panel, touch the Setup button.
      b. Open the Fax Setup menu.
      c. Open the Advanced Setup menu.
d. Open the Fax Speed menu.
e. Select the correct setting.

- Contact your service provider to make sure that fax is supported and for a recommended fax speed settings. Some companies might require an adapter.

### An error message displays on the control panel

#### The No fax detected. message displays

![NOTE:](#) This error does not always refer to a missed fax. If a voice call is made to a fax number by mistake and the caller hangs up, the **No fax detected.** message displays on the control panel.

- Ask the sender to resend the fax.
- Make sure that the telephone cord from the product is connected to the wall telephone jack.
- Try a different phone cord.
- Connect the product phone cord to a jack for another phone line.
- Make sure the telephone line and phone wall jack are active by connecting a telephone and checking for a dial tone.
- Make sure that the telephone cord is connected to the “line” port on the product.
- Check the phone line by running a fax test from the control panel.
- If the error persists, contact HP. See [www.hp.com/support/ljmfpM521series](http://www.hp.com/support/ljmfpM521series) or the support flyer that came in the product box.

#### The Communication error message appears

- Ask the sender to send the fax again or send at a later time when line conditions have improved.
- Disconnect the product telephone cord from the wall, connect a telephone to the phone jack on the wall, and try making a call. Plug the product phone cord into a jack for another phone line.
- Try a different phone cord.
- Set the Fax Speed option to the Slow(V.29) or Medium(V.17) setting.
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Fax Setup menu.
  c. Open the Advanced Setup menu.
  d. Open the Fax Speed menu.
  e. Select the correct setting.
- Turn off the Error Correction feature to prevent automatic error correction.

![NOTE:](#) Turning off the Error Correction feature can reduce image quality.
a. From the Home screen on the product control panel, touch the Setup button.

b. Open the Service menu.

c. Open the Fax Service menu.

d. Open the Error Correction menu.

e. Select the Off setting.

• Print the Fax Activity Log report from the control panel to determine if the error occurs with a specific fax number.

a. Touch the Fax button, and then touch the Fax Menu button.

b. Open the Fax Reports menu.

c. Open the Fax Activity Log menu.

d. Select the Print Log Now option.

• If the error persists, contact HP. See www.hp.com/support/ljmfpM521series or the support flyer that came in the product box.

### The Fax storage is full message appears

• Turn the product off then on.

• Print all of the faxes, and then have the sender resend the fax.

• Ask the sender to divide a large fax job into smaller sections, and then fax them individually.

• Make sure that the resolution of the sending fax machine is not set to the Photo setting or the Superfine setting.

a. From the Home screen on the product control panel, touch the Setup button.

b. Open the Fax Setup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Resolution menu.

e. Select the correct setting.

• Cancel all fax jobs or clear the faxes from memory.

### The Fax is busy message appears

• The product cannot receive a fax while attempting to send one. Cancel the fax send and try sending at a later time.

• Allow the product to try sending the fax again.
A fax is received but does not print

The Private Receive feature is on

- When the Private Receive feature is activated, received faxes are stored in memory. A password is required to print the stored faxes.
- Enter the password to print the fax. If you do not know the password, contact the product administrator.

**NOTE:** Memory errors might occur if the faxes are not printed. The product will not answer if the memory is full.

Sender receives a busy signal

A handset is connected to the product

- Make sure the phone is hung up.
- Change the Answer Mode option to match the product setup.
  a. From the Home screen on the product control panel, touch the Setup button.
  b. Open the Fax Setup menu.
  c. Open the Basic Setup menu.
  d. Open the Answer Mode menu.
  e. Select the setting that matches the product setup.

Set the Answer Mode option to the Fax/Tel setting to automatically receive faxes. The Fax/Tel setting automatically detects whether the incoming transmission is a fax or a voice call and routes the call to the appropriate device.

A phone line splitter is being used

- If you are using a phone line splitter, remove the splitter and set up the phone as a downstream phone.
- Make sure the phone is hung up.
- Make sure the phone is not being used for a voice call when faxing.

No dial tone

- If using a phone line splitter, remove the phone line splitter and set up the phone as a downstream phone.

Cannot send or receive a fax on a PBX line

- If you are using a PBX phone line, contact your PBX administrator to configure an analog fax line for your product.

Solve general fax problems

- Faxes are sending slowly
- Fax quality is poor
● Fax cuts off or prints on two pages

**Faxes are sending slowly**

The product is experiencing poor phone line quality.

- Retry sending the fax when the line conditions have improved.
- Check with the phone service provider that the line supports fax.
- Turn off the Error Correction setting.
  a. Open the Setup Menu menu.
  b. Open the Service menu.
  c. Open the Fax Service menu.
  d. Open the Error Correction menu.
  e. Select the Off setting.

NOTE: This can reduce image quality.

- Use white paper for the original. Do not use colors such as gray, yellow, or pink.
- Increase the Fax Speed setting.
  a. Open the Setup Menu menu.
  b. Open the Fax Setup menu.
  c. Open the Advanced Setup menu.
  d. Open the Fax Speed menu.
  e. Select the correct setting.
- Divide large fax jobs into smaller sections, and then fax them individually.
- Change the fax settings on the control panel to a lower resolution.
  a. Open the Setup Menu menu.
  b. Open the Fax Setup menu.
  c. Open the Advanced Setup menu.
  d. Open the Fax Resolution menu.
  e. Select the correct setting.

**Fax quality is poor**

Fax is blurry or light.

- Increase fax resolution when sending faxes. Resolution does not affect received faxes.
  a. Open the Setup Menu menu.
  b. Open the Fax Setup menu.
c. Open the Advanced Setup menu.
d. Open the Fax Resolution menu.
e. Select the correct setting.

**NOTE:** Increasing resolution slows transmission speed.

- Turn on the Error Correction setting from the control panel.
  a. Open the Setup Menu menu.
  b. Open the Service menu.
  c. Open the Fax Service menu.
  d. Open the Error Correction menu.
  e. Select the On setting.

- Check the toner cartridges and replace if necessary.
- Ask the sender to darken the contrast setting on the sending fax machine, and then resend the fax.

**Fax cuts off or prints on two pages**

  a. Open the Setup Menu menu.
  b. Open the System Setup menu.
  c. Open the Paper Setup menu.
  d. Open the Default Paper Size menu.
  e. Select the correct setting.

- Set the paper type and size for the tray used for faxes.
- Turn on the Fit to Page setting to print longer length faxes on letter or A4 size paper.
  a. Open the Setup Menu menu.
  b. Open the Fax Setup menu.
  c. Open the Advanced Setup menu.
  d. Open the Fit to Page menu.
  e. Select the On setting.

**NOTE:** If the Fit to Page setting is off and the Default Paper Size setting is set to letter, a legal size original prints on two pages.
Solve USB connection problems

If you have connected the product directly to a computer, check the cable.

- Verify that the cable is connected to the computer and to the product.
- Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.
- Verify that the cable is working correctly by connecting it to another product. Replace the cable if necessary.
Solve wired network problems

Check the following items to verify that the product is communicating with the network. Before beginning, print a configuration page from the product control panel and locate the product IP address that is listed on this page.

- **Poor physical connection**
- **The computer is using the incorrect IP address for the product**
- **The computer is unable to communicate with the product**
- **The product is using incorrect link and duplex settings for the network**
- **New software programs might be causing compatibility problems**
- **The computer or workstation might be set up incorrectly**
- **The product is disabled, or other network settings are incorrect**

**NOTE:** HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems and not of the HP print drivers. For more information, go to Microsoft at [www.microsoft.com](http://www.microsoft.com).

**Poor physical connection**

1. Verify that the product is attached to the correct network port using a cable of the correct length.
2. Verify that cable connections are secure.
3. Look at the network port connection on the back of the product, and verify that the amber activity light and the green link-status light are lit.
4. If the problem continues, try a different cable or port on the hub.

**The computer is using the incorrect IP address for the product**

1. Open the printer properties and click the **Ports** tab. Verify that the current IP address for the product is selected. The product IP address is listed on the product configuration page.
2. If you installed the product using the HP standard TCP/IP port, select the box labeled **Always print to this printer, even if its IP address changes.**
3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of the IP address.
4. If the IP address is correct, delete the product and then add it again.

**The computer is unable to communicate with the product**

1. Test network communication by pinging the network.
a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and then type cmd.

b. Type ping followed by the IP address for your product.
   For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in the Ping pane.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network settings, the product, and the computer are all configured for the same network.

**The product is using incorrect link and duplex settings for the network**

HP recommends leaving this setting in automatic mode (the default setting). If you change these settings, you must also change them for your network.

**New software programs might be causing compatibility problems**

Verify that any new software programs are correctly installed and that they use the correct print driver.

**The computer or workstation might be set up incorrectly**

1. Check the network drivers, print drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

**The product is disabled, or other network settings are incorrect**

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.
Solve wireless network problems

- Wireless connectivity checklist
- The product does not print after the wireless configuration completes
- The product does not print, and the computer has a third-party firewall installed
- The wireless connection does not work after moving the wireless router or product
- Cannot connect more computers to the wireless product
- The wireless product loses communication when connected to a VPN
- The network does not appear in the wireless networks list
- The wireless network is not functioning
- Perform a wireless network diagnostic test
- Reduce interference on a wireless network

Wireless connectivity checklist

- Verify that the network cable is not connected.
- Verify that the product and the wireless router are turned on and have power. Also make sure that the wireless radio in the product is turned on.
- Verify that the service set identifier (SSID) is correct. Print a configuration page to determine the SSID. If you are not sure the SSID is correct, run the wireless setup again.
- With secured networks, verify that the security information is correct. If the security information is incorrect, run the wireless setup again.
- If the wireless network is working correctly, try accessing other computers on the wireless network. If the network has Internet access, try connecting to the Internet over a wireless connection.
- Verify that the encryption method (AES or TKIP) is the same for the product as it is for the wireless access point (on networks using WPA/WPA2 security).
- Verify that the product is within the range of the wireless network. For most networks, the product must be within 30 m (100 ft) of the wireless access point (wireless router).
- Verify that obstacles do not block the wireless signal. Remove any large metal objects between the access point and the product. Make sure poles, walls, or support columns containing metal or concrete do not separate the product and wireless access point.
- Verify that the product is located away from electronic devices that might interfere with the wireless signal. Many devices can interfere with the wireless signal including motors, cordless phones, security system cameras, other wireless networks, and some Bluetooth devices.
- Verify that the print driver is installed on the computer.
- Verify that you have selected the correct printer port.
- Verify that the computer and product connect to the same wireless network.
- For Mac OS X, verify that the wireless router supports Bonjour.
The product does not print after the wireless configuration completes

1. Make sure that the product is turned on and in the ready state.
2. Turn off any third-party firewalls on your computer.
3. Make sure that the wireless network is working correctly.
4. Make sure that your computer is working correctly. If necessary, restart the computer.
5. Verify that you can open the product HP Embedded Web Server from a computer on the network.

The product does not print, and the computer has a third-party firewall installed

1. Update the firewall with the most recent update available from the manufacturer.
2. If programs request firewall access when you install the product or try to print, make sure you allow the programs to run.
3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable the firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless router or product

1. Make sure that the router or product connects to the same network that your computer connects to.
2. Print a configuration page.
3. Compare the service set identifier (SSID) on the configuration page to the SSID in the printer configuration for the computer.
4. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure the wireless setup for the product.

Cannot connect more computers to the wireless product

1. Make sure that the other computers are within the wireless range and that no obstacles block the signal. For most networks, the wireless range is within 30 m (100 ft) of the wireless access point.
2. Make sure that the product is turned on and in the ready state.
3. Turn off any third-party firewalls on your computer.
4. Make sure that the wireless network is working correctly.
5. Make sure that your computer is working correctly. If necessary, restart the computer.

The wireless product loses communication when connected to a VPN

- Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list

- Make sure the wireless router is turned on and has power.
- The network might be hidden. However, you can still connect to a hidden network.
The wireless network is not functioning

1. Make sure that the network cable is not connected.
2. To verify if the network has lost communication, try connecting other devices to the network.
3. Test network communication by pinging the network.
   a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and then type cmd.
   b. Type ping followed by the router IP address.
      For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in the Ping pane.
   c. If the window displays round-trip times, the network is working.
4. Make sure that the router or product connects to the same network that the computer connects to.
   a. Print a configuration page.
   b. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer configuration for the computer.
   c. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure the wireless setup for the product.

Perform a wireless network diagnostic test

From the product control panel, you can run a diagnostic test that provides information about the wireless network settings.

1. From the Home screen on the product control panel, touch the Setup button.
2. Open the Self Diagnostics menu.
3. Touch the Run Wireless Test button to start the test. The product prints a test page that shows test results.

Reduce interference on a wireless network

The following tips can reduce interference in a wireless network:

- Keep the wireless devices away from large metal objects, such as filing cabinets, and other electromagnetic devices, such as microwaves and cordless telephones. These objects can disrupt radio signals.
- Keep the wireless devices away from large masonry structures and other building structures. These objects can absorb radio waves and lower signal strength.
- Position the wireless router in a central location in line of sight with the wireless products on the network.
Solve product software problems with Windows

- A print driver for the product is not visible in the Printer folder
- An error message was displayed during the software installation
- The product is in Ready mode, but nothing prints

A print driver for the product is not visible in the Printer folder

1. Reinstall the product software.

   **NOTE:** Close any applications that are running. To close an application that has an icon in the system tray, right-click the icon, and select **Close** or **Disable**.

2. Try connecting the USB cable to a different USB port on the computer.

An error message was displayed during the software installation

1. Reinstall the product software.

   **NOTE:** Close any applications that are running. To close an application that has an icon in the system tray, right-click the icon, and select **Close** or **Disable**.

2. Check the amount of free space on the drive where you are installing the product software. If necessary, free up as much space as you can, and reinstall the product software.

3. If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready mode, but nothing prints

1. Print a configuration page, and verify the product functionality.

2. Verify that all of the cables are correctly seated and within specifications. This includes the USB and power cables. Try a new cable.

3. Verify the IP address on the configuration page matches the IP address for the software port. Use one of the following procedures:


   a. Click **Start**.

   b. Click **Settings**.

   c. Click **Printers and Faxes** (using the default Start menu view) or click **Printers** (using the Classic Start menu view).

   d. Right-click the product driver icon, and then select **Properties**.

   e. Click the **Ports** tab, and then click **Configure Port**.

   f. Verify the IP address, and then click **OK** or **Cancel**.

   g. If the IP addresses are not the same, delete the driver, and reinstall the driver using the correct IP address.
Windows 7

a. Click **Start**.

b. Click **Devices and Printers**.

c. Right-click the product driver icon, and then select **Printer properties**.

d. Click the **Ports** tab, and then click **Configure Port**.

e. Verify the IP address, and then click **OK** or **Cancel**.

f. If the IP addresses are not the same, delete the driver, and reinstall the driver using the correct IP address.
Solve product software problems with Mac OS X

- **The print driver is not listed in the Print & Fax or Print & Scan list**

- **The product name does not appear in the product list in the Print & Fax or Print & Scan list**

- **The print driver does not automatically set up the selected product in the Print & Fax or Print & Scan list**

- **A print job was not sent to the product that you wanted**

- **When connected with a USB cable, the product does not appear in the Print & Fax or Print & Scan list after the driver is selected.**

- **You are using a generic print driver when using a USB connection**

**The print driver is not listed in the Print & Fax or Print & Scan list**

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/PPDs/Contents/Resources. If necessary, reinstall the software.

2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the software.

**The product name does not appear in the product list in the Print & Fax or Print & Scan list**

1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration page matches the product name in the Print & Fax (Print & Scan in Mac OS X v10.7) list.

3. Use the + button to add the product to the Print & Fax (Print & Scan in Mac OS X v10.7) list.

4. Replace the USB or network cable with a high-quality cable.

**The print driver does not automatically set up the selected product in the Print & Fax or Print & Scan list**

1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/PPDs/Contents/Resources. If necessary, reinstall the software.

3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the software.

4. Use the + button to add the product to the Print & Fax (Print & Scan in Mac OS X v10.7) list.

5. Replace the USB or network cable with a high-quality cable.

**A print job was not sent to the product that you wanted**

1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a configuration page to check the product name. Verify that the name on the configuration page matches the product name in the Print & Fax (Print & Scan in Mac OS X v10.7) list.
When connected with a USB cable, the product does not appear in the Print & Fax or Print & Scan list after the driver is selected.

Software troubleshooting

1. Make sure that your Mac operating system is Mac OS X 10.6 or later.
2. Use the + button to add the product to the Print & Fax (Print & Scan in Mac OS X v10.7) list.

Hardware troubleshooting

1. Make sure that the product is turned on.
2. Make sure that the USB cable is connected correctly.
3. Make sure that you are using the appropriate Hi-Speed USB cable.
4. Make sure that you do not have too many USB devices drawing power from the chain. Disconnect all of the devices from the chain, and then connect the cable directly to the USB port on the computer.
5. Check to see if more than two non-powered USB hubs are connected in a row on the chain. Disconnect all of the devices from the chain, and then connect the cable directly to the USB port on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic print driver when using a USB connection

If you connected the USB cable before you installed the software, you might be using a generic print driver instead of the driver for this product.

1. Delete the generic print driver.
2. Reinstall the software from the product CD. Do not connect the USB cable until the software installation program prompts you.
3. If multiple printers are installed, make sure that you have selected the correct printer in the Format For drop-down menu in the Print dialog box.
Remove software (Windows)

Windows XP
1. Click **Start**, and then click **Programs**.
2. Click **HP**, and then click the product name.
3. Click **Uninstall**, and then follow the on-screen instructions to remove the software.

Windows Vista and Windows 7
1. Click **Start**, and then click **All Programs**.
2. Click **HP**, and then click the product name.
3. Click **Uninstall**, and then follow the on-screen instructions to remove the software.
Remove software (Mac OS X)

You must have administrator rights to remove the software.

1. Disconnect the product from the computer.

2. Open Applications.

3. Open Hewlett Packard.

4. Open HP Uninstaller.

5. Select the product from the list of devices, and then click the Uninstall button.

6. After the software is uninstalled, restart the computer and empty the Trash.
Solve scan to email problems

If scan to email problems occur, try these solutions:

- Make sure this feature has been set up. If this feature has not been set up, use the setup wizard in the HP Device Toolbox (Windows) or HP Utility for Mac OS X software to set it up.

- Make sure the Scan to Email feature is enabled. If it has been disabled, enable the feature through the HP Device Toolbox (Windows) or HP Utility for Mac OS X software.

- Make sure the product is connected to a computer or to a network.

Cannot connect to the email server

- Make sure the SMTP server name is correct. Check this setting with your system administrator or Internet Service Provider.

- If the product cannot establish a secure connection to the SMTP server, try without the secure connection or try a different server or port. Check this setting with your system administrator or Internet Service Provider.

- If the SMTP server requires authentication, make sure a valid user name and password are used.

- If the SMTP server uses an authentication method that is not supported, try a different server. Check this setting with your system administrator or Internet Service Provider.

The email failed

- Verify that email addresses entered are correct.

- If the size of the email was too large, send fewer pages or reduce the scan resolution.

Unable to scan

- If you are prompted for a PIN, enter the correct PIN for the outgoing profile.

- Make sure at least one email address is selected in the To field.
Solve scan to network folder problems

If scan to network folder problems occur, try these solutions:

- Make sure this feature has been set up. If this feature has not been set up, use the setup wizard in the HP Device Toolbox (Windows) or HP Utility for Mac OS X software to set it up.
- Make sure the Scan to Network Folder feature is enabled. If it has been disabled, enable the feature through the HP Device Toolbox (Windows) or HP Utility for Mac OS X software.
- Make sure the product is connected to a network.
- Use the test option on the Scan tab of the HP Device Toolbox (Windows) or the HP Utility (Mac OS X) to verify the Scan to Network Folder feature is set up correctly.

The scan failed

- Make sure the network path is in the correct format (//host/share/path) and the folder exists.
- Make sure the network directory is readable and writeable.
- If you are using the default file names for scanned documents, make sure there are no conflicting file names. Remove some of the previously scanned documents.
- Use the IP address instead of the host name. Make sure the product and host are connected to the same network.
- If the network folder is password protected, make sure to enter the correct user name and password.
- If a Disk full message displays, remove some files from the network folder.
- Turn the product off, and then on. Scan again.
Index

Accessories  
- part numbers 33
accessories  
- ordering 26
AirPrint 80
answer mode, setting 120
answering machines, connecting 111
  - fax settings 121
anticounterfeit supplies 28
applications  
- downloading 140
Apps menu 140
archival-quality printing 78
autoreduction settings, fax 123

Billing codes, fax  
- using 119
Bins, output  
- locating 4
  - selecting 23
blocking faxes 121
booklets  
- creating (Windows) 69
  - printing (Mac) 76
busy signals, redialing options 117

caller-ID boxes, connecting 111
canceling  
- faxes 126
  - print job (Mac) 77
  - print job (Windows) 71
cartridges  
- non-HP 27, 35
  - order numbers 35
  - recycling 35
  - replacing 36
  - storage 35
  - supplies status page 11
checklist  
- fax troubleshooting 195
  - for solving problems 154
  - wireless connectivity 215
cleaning  
- glass 182, 186, 189
  - paper path 178
collating copies 90
configuration page 11
contrast settings  
- copy 95
  - fax 118
control panel  
- buttons and lights 8
  - help 10, 158
Home screen 9
locating 4
menu map, printing 11
Reports menu 11

copying  
- collation 90
- contrast, adjusting 95
- draft mode 96
- enlarging 93
- light/dark settings 95
- multiple copies 87
- multiple-page originals 88
- paper size and type 97
- quality, adjusting 94
- reducing 93
- restore default settings 85
- set new default settings 84
- single copies 86
- two-sided documents 91, 92
counterfeit supplies 28
cover pages  
- printing on different paper  
  - (Windows) 64
covers, locating 4
custom-size copies 93
customer self-repair  
- part numbers 31
darkness, contrast settings  
- copy 95
  - fax 118
default copy settings  
- changing 84
  - restoring to factory settings 85
default gateway, setting 141
defaults, restoring 157
delaying fax sending 132
deleting faxes from memory 127
dial tone detection settings 116
dialing  
- from a telephone 132
  - pauses, inserting 116
  - prefixes, inserting 116
  - redialing automatically, settings 117
  - tone or pulse settings 117
distinctive-ring settings 122
document feeder 91
copying two-sided documents 91
  - jams 162
  - paper-feeding problems 159
double-sided copying 91, 92
double-sided printing  
- Mac 74
  - Windows 53
draft mode, copying 96
HP Utility for Mac
Bonjour 146
features 146
HP Utility, Mac 146
HP Web Jetadmin 147
HP Web Services
  applications 140
  enabling 140
HP Web Services, enabling 79

I
identification cards
  copying 89
interface ports
  locating 5, 6
IPv4 address 141
ISDN
  faxing 127

J
jams
  causes of 160
  document feeder, clearing 162
duplexer 175
fuser 173
locations 161
output bin 164
  tracking number of 11
Tray 1 166
Tray 2 169
Jetadmin, HP Web 147

L
labels
  output bin, selecting 23
  printing (Windows) 61
landscape orientation
  changing (Mac) 75
  selecting, Windows 59
last page
  printing on different paper
    (Windows) 64
lightness
  copy contrast 95
  fax contrast 118
link speed settings 143
loading
toner cartridges 34
  Tray 1 18
  Tray 2 21
lock
  product 150
logs, fax
  error 198
  printing all 197

M
Mac
  driver settings 44, 73
  problems, troubleshooting 220
  scanning from TWAIN-compliant software 106
Macintosh
  HP Utility 146
maintenance kits
  part numbers 31
managing network 141
manual duplex
  Mac 74
  Windows 53
media
  loading Tray 1 18
  loading Tray 2 21
memory
  deleting faxes 127
  included 2
  reprinting faxes 135
menus, control panel
  map, printing 11
Microsoft Word, faxing from 131
modems, connecting 111
multiple copies 87
multiple pages per sheet
  printing (Mac) 75
  printing (Windows) 57
multiple-page originals
  copying 88

N
network
  password, changing 150
  password, setting 150
  product name, changing 141
  settings, changing 141
  settings, viewing 141
networks
  configuration page 11
  default gateway 141
HP Web Jetadmin 147
installing the product 138
IPv4 address 141
models supporting 2
settings report 11
subnet mask 141
non-HP supplies 27, 35
number of copies, changing 87

O
on/off button, locating 4
online help, control panel 10, 158
ordering
  supplies and accessories 106
orientation
  changing (Mac) 75
  selecting, Windows 59
output bin
  jams 164
  locating 4
outside lines
  dial prefixes 116
  pauses, inserting 116

P
page count 11
page orientation
  changing (Mac) 75
page sizes
  scaling documents to fit (Mac) 76
  scaling documents to fit (Windows) 67
pages per minute 2
pages per sheet
  selecting (Mac) 75
  selecting (Windows) 57
paper
  covers, using different paper 64
  fax autoreduction settings 123
  first and last pages, using different paper 64
  jams 160
  loading Tray 1 18
  loading Tray 2 21
ordering 26
  selecting 179
  supported paper sizes 14
  supported sizes 14
  supported types 16
paper jams. See jams
paper pickup problems solving 159
paper size changing 70
paper sizes
   copy settings 97
   selecting (Mac) 76
   selecting custom sizes (Mac) 77
   selecting custom sizes (Windows) 70
paper type
   selecting (Windows) 61
paper types
   copy settings 97
   selecting (Mac) 75
paper, covers printing (Mac) 75
part numbers
   customer self-repair 31
   maintenance kits 31
   supplies 31
   trays 33
pauses, inserting 116
PBX
   faxing 127
PCL drivers
   universal 40
   PCL font list 11
phone book, fax
   adding entries 130
phones
   receiving faxes from 112, 136
   phones, connecting extra 111
   phones, downstream
      sending faxes from 132
polling faxes 125
portrait orientation
   changing (Mac) 75
   selecting, Windows 59
ports
   locating 6
postcards
   output bin, selecting 23
power connection
   locating 5, 6
power switch, locating 4
power-down delay
   setting 148
prefixes, dial 116
presets (Mac) 73
print drivers
   selecting 180
   supported 40
print drivers (Mac)
   changing settings 44
   settings 73
print drivers (Windows)
   changing settings 42
print job
   canceling (Mac) 77
   canceling (Windows) 71
print on both sides
   Mac 74
   manually, Windows 53
   Windows 53
print quality
   improving 177
printing
   from USB flash drives 81
   product reports 11
   settings (Mac) 73
printing on both sides
   settings (Windows) 51
private receive 124
problem-solving
   no response 193
   slow response 193
protocol settings, fax 198
PS font list 11
pulse-dialing 117
R
rear output bin
   printing to 23
receiving faxes
   answer mode, setting 120
   autoreduction settings 123
   blocking 121
   error report, printing 198
   from extension phone 112
   polling 125
   reprinting 135
   reprinting faxes 123
   ring patterns, settings 122
   rings-to-answer settings 121
   stamp-received setting 124
   when you hear fax tones 136
recycling supplies 35
redialing
   automatically, settings 117
reducing documents
   copying 93
replacing printing cartridges 36
reports
   configuration report 11
   demo page 11
   menu structure 11
   network summary 11
   PCL font list 11
   PCL6 font list 11
   print quality page 11
   PS font list 11
   service page 11
   supplies status 11
   usage page 11
Reports menu 11
reports, fax
   error 198
   printing all 197
   reprinting faxes 123, 135
resize documents
   copying 93
   Mac 76
   Windows 67
resolution
   fax 118
restoring factory-set defaults 157
ring patterns 122
ring tones
   distinctive 122
   rings-to-answer setting 121
rough paper
   output bin, selecting 23
S
scale documents
   Mac 76
   Windows 67
scaling documents
   copying 93
scanner
   glass cleaning 182, 186, 189
scanning
   from HP Scan software (Mac) 101
   from HP Scan software (Windows) 100
to email, setup 103
to network folder, setup 103
TWAIN-compliant software 106
WIA-compliant software 106
sending faxes
billing codes 119
canceling 126
confirmation 132
delaying 132
error report, printing 198
forwarding 120
from downstream telephone 132
from software 131
service page 11
settings
driver presets (Mac) 73
drivers 42
drivers (Mac) 44
factory-set defaults, restoring 157
network report 11
setup
scan to email and network folder 103
shortcuts (Windows)
creating 48
using 46
size, copy
reducing or enlarging 93
sizes, media
Fit to Page setting, faxing 123
sleep delay
disabling 148
enabling 148
small documents
copying 89
small paper
output bin, selecting 23
software
HP Utility 146
problems 218
scanning from TWAIN or WIA 106
sending faxes 131
uninstalling for Mac 223
uninstalling for Windows 222
solve
fax problems 199
solve problems
fax 209
solving
walk-up USB printing problems 194
special paper
printing (Windows) 61
special paper for covers
printing (Mac) 75
speed dials
programming 130
speed-dial entries
creating 114
deleting 115
editing 114
status
Home screen, control panel 9
HP Utility, Mac 146
supplies, printing report 11
storing
toner cartridges 35
straight-through paper path 23
subnet mask 141
supplies
counterfeit 28
low threshold settings 29
non-HP 27, 35
ordering 26
part numbers 31
recycling 35
replacing toner cartridges 36
status, viewing with HP Utility for Mac 146
using when low 29
supplies status page 11
supported paper 14
T
TCP/IP
manually configuring IPv4 parameters 141
telephones
receiving faxes from 112, 136
telephones, connecting extra 111
telephones, downstream
sending faxes from 132
tone-dialing 117
toner cartridge
low threshold settings 29
using when low 29
toner cartridges
loading 34
non-HP 27, 35
order numbers 35
recycling 35
replacing 36
storage 35
supplies status page 11
top output bin
printing to 23
transparencies
output bin 23
printing (Windows) 61
Tray 1
jams 166
loading 18
tray 1
capacity 17
Tray 2
jams 169
loading 21
tray 2
capacity 20
trays
included 2
locating 4
part numbers 33
troubleshooting
checklist 154
fax error-correction setting 198
faxes 195
jams 160
Mac problems 220
network problems 213
paper feed problems 159
receive fax 204
send fax 199
USB connection 212
walk-up USB printing problems 194
Windows problems 218
wired network 213
wireless network 215
TWAIN-compliant software, scanning from 106
two-sided copying 91, 92
two-sided printing
settings (Windows) 51
U
unblocking fax numbers 121
uninstalling Mac software 223
uninstalling Windows software 222
universal print driver 40
usage page 11
USB connection
troubleshooting 212
USB flash drives
printing from 81

V
V.34 setting 198
VoIP
faxing 128
volume, adjusting 123

W
walk-up USB printing 81
watermarks
printing (Mac) 77
printing (Windows) 71
Web Services
applications 140
enabling 140
Web sites
fraud reports 28
HP Web Jetadmin, downloading
147
universal print driver 40
WIA-compliant software, scanning
from 106
Windows
driver settings 42
faxing from 131
scanning from TWAIN or WIA
software 106
universal print driver 40
Windows print drivers
supported 40
wireless network
troubleshooting 215
wireless network interference 217
wireless printing
solving problems 154
Word, faxing from 131